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Safety Instructions

Safety Instructions ¢ English

WARNING: This symbol, 4\, when used on the product, is intended to
alert the user of the presence of uninsulated dangerous voltage within the
product’s enclosure that may present a risk of electric shock.

ATTENTION: This symbol, A\, when used on the product, is intended
to alert the user of important operating and maintenance (servicing)
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF
compatibility, accessibility, and related topics, see the Extron Safety and
Regulatory Compliance Guide, part number 68-290-01, on the Extron website,
www.extron.com.

Instructions de sécurité ¢ Francais

AVERTISSEMENT: Ce pictogramme, A\, lorsqu'il est utilisé sur le
produit, signale a I'utilisateur la présence a I'intérieur du boitier du produit
d’une tension électrique dangereuse susceptible de provoquer un choc
électrique.

ATTENTION: Ce pictogramme, A\, lorsqu’il est utilisé sur le produit,
signale a I'utilisateur des instructions d’utilisation ou de maintenance
importantes qui se trouvent dans la documentation fournie avec le
matériel.

Pour en savoir plus sur les regles de sécurité, la conformité a la réglementation,
la compatibilité EMI/EMF, I'accessibilité, et autres sujets connexes, lisez les
informations de sécurité et de conformité Extron, réf. 68-290-01, sur le site
Extron, www.extron.com.

Sicherheitsanweisungen ¢ Deutsch

WARNUNG: Dieses Symbol A auf dem Produkt soll den Benutzer
darauf aufmerksam machen, dass im Inneren des Gehé&uses dieses
Produktes geféhrliche Spannungen herrschen, die nicht isoliert sind
und die einen elektrischen Schlag verursachen kénnen.

VORSICHT: Dieses Symbol /A auf dem Produkt soll dem Benutzer in der
im Lieferumfang enthaltenen Dokumentation besonders wichtige Hinweise
zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen Uber die Sicherheitsrichtlinien, Produkthandhabung,
EMI/EMF-Kompatibilitét, Zuganglichkeit und verwandte Themen finden Sie in
den Extron-Richtlinien fir Sicherheit und Handhabung (Artikelnummer
68-290-01) auf der Extron-Website, www.extron.com.

Instrucciones de seguridad ¢ Espanol

ADVERTENCIA: Este simbolo, 4\, cuando se utiliza en el producto,
avisa al usuario de la presencia de voltaje peligroso sin aislar dentro del
producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCION: Este simbolo, A\, cuando se utiliza en el producto, avisa
al usuario de la presencia de importantes instrucciones de uso y
mantenimiento recogidas en la documentacién proporcionada con el
equipo.

Para obtener informacion sobre directrices de seguridad, cumplimiento

de normativas, compatibilidad electromagnética, accesibilidad y temas
relacionados, consulte la Guia de cumplimiento de normativas y seguridad de
Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.com.

UHCTPYKUMa No TexHuke 6e3onacHocTu ¢ Pycckuii

NMPEAYNPEXAEHUE:  [aHHbli CUMBON, A\, ecnn ykasaH
Ha NpoaykTe, npeaynpexaaeT nofib3oBaTeNs O Hanm4ymum
HEN30IMPOBAHHOIO ONACHOI0 HAMPSHXKEHUS BHYTPWU Kopnyca
npoaykTa, KoTopoe MOXET NMPMBECTU K MOPaXEHMUIO
ANEKTPUYECKNUM TOKOM.

BHUMAHME: [anHbii cumBon, A\, ecnv ykasaH Ha NpoaykTe,
npeaynpexaaeT Nonb30BaTesns 0 HANMNYMN BaXHbIX MHCTPYKLUMIA
no akcnayataumm n o6CnyXXmBaHuio B pyKOBOACTBE,
npusaraemMom K AaHHoMy 060pyA0BaHNIO.

[na nonydeHns nHopmaumm o npasusiax TeEXHUKM 6e30nacHoCTu,
cob61I0AEHNN HOPMATUBHBIX TPEOOBAHWI, S1EKTPOMArHUTHOM
cosmecTumocTn (SMIM/3AC), BO3MOXHOCTM A0CTyNna 1 Apyrnx
BOMpPOCax CM. PyKOBOACTBO Mo 6e30rnacHOCTU 1 co6t0aeHNI0
HOpMaTMBHbIX TpebosaHuii Extron Ha cavite Extron: www.extron.com,
HOMep no Katanory - 68-290-01.

Chinese Simplified (&i{#FH3z)
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BB ER.
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Chinese Traditional (Z&2H37)
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FCC Class A Notice

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to part 15 of the FCC rules. The Class A limits provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause interference. This interference must be corrected at
the expense of the user.

NOTE: For more information on safety guidelines, regulatory compliances, EMI/EMF compatibility,
accessibility, and related topics, see the “Extron Safety and Regulatory Compliance
Guide” on the Extron website.

Copyright
© 2014 Extron Electronics. All rights reserved.

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.

The following registered trademarks®, registered service marks®", and trademarks™ are the property of
RGB Systems, Inc. or Extron Electronics:

Registered Trademarks

AVTrac, Cable Cubby, CrossPoint, eBUS, EDID Manager, EDID Minder, Extron, Flat Field, GlobalViewer, Hideaway, Inline, IP Intercom,
IP Link, Key Minder, Locklt, MediaLink, PlenumVault, PoleVault, PowerCage, PURES3, Quantum, SoundField, SpeedMount, SpeedSwitch,
System INTEGRATOR, TeamWork, TouchLink, V-Lock, VersaTools, VN-Matrix, VoiceLift, WallVault, WindoWall, XTP, and XTP Systems

Registered Service Mark®" : S3 Service Support Solutions

Trademarks (™

AAP, AFL (Accu-Rate Frame Lock), ADSP (Advanced Digital Sync Processing), Auto-Image, CDRS (Class D Ripple Suppression), CableCover,
DDSP (Digital Display Sync Processing), DMI (Dynamic Motion Interpolation), Driver Configurator, DSP Configurator, DSVP (Digital Sync
Validation Processing), EQIB, FastBite, FOXBOX, Global Configurator, IP Intercom HelpDesk, MAAP, MicroDigital, ProDSP, QS-FPC (QuickSwitch
Front Panel Controller), Scope-Trigger, SIS, Simple Instruction Set, Skew-Free, SpeedNav, Triple-Action Switching, XTRA, ZipCaddy, ZipClip
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Conventions Used in this Guide

Notifications
The following naotifications are used in this guide:

ATTENTION:
e Risk of property damage.
e Risque de dommages matériels.

I NOTE: A note draws attention to important information.

I TIP: A tip provides a suggestion to make working with the application easier.

Software Commands

Commands are written in the fonts shown here:
“ARMerge Scene,,0Op1 scene 1,1"B51"W"C
[01]1RO0D4 0030000400 30800 0A603 [@2]35[17] [93]

[Esc] ] *[xi7]* [x20]* X23]* [x21] CE +=

NOTE: For commands and examples of computer or device responses mentioned
in this guide, the character “@” is used for the number zero and “0” is the capital
letter “0.”

Computer responses and directory paths that do not have variables are written in the font
shown here:

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron
Variables are written in slanted form as shown here:

ping Xxx.XXX.XXxX.xxx —t

SOH R Data STX Command ETB ETX
Selectable items, such as menu names, menu options, buttons, tabs, and field names are
written in the font shown here:

From the File menu, select New.

Click the OK button.

Specifications Availability

Product specifications are available on the Extron website, www.extron.com.
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Introduction

This section gives an overview of the guide and features of the Quantum Elite Control
Software and Quantum Connect Control Software. Topics include:

e About this Guide
e Overview of the Quantum Control Software
e Features

About this Guide

This guide provides detailed information about the Quantum Elite Control Software and
Quantum Connect Control Software, including software installation and configuration.
This guide also describes how these applications control the Quantum Elite and Quantum
Connect videowall processors.

The features and functionality described in this guide are based on using version 1.8 of
the Quantum control software applications with Quantum Elite and Quantum Connect
firmware version 9.0 and later. For the latest details on firmware and software, visit
www.extron.com.

In this guide, the term “Quantum Control Software” refers to both the Quantum Elite Control
Software and Quantum Connect Control Software. The terms “Quantum” and “Quantum
processor” refer to both the Quantum Elite and Quantum Connect videowall processors.
Notes distinguish where features differ between the Quantum Elite and Connect Control
Software programs and between the Quantum Elite and Connect processors.

Overview of the Quantum Control Software

Quantum Elite Control Software and Quantum Connect Control Software are Microsoft®
Windows®-based applications that are used to control the Quantum Elite and Quantum
Connect videowall processors. These products form part of the Extron Quantum series.

With the Quantum Control Software, the Quantum Elite and Connect can display multiple
image sources on a single target display or multiple target displays. External analog and
digital video sources (such as PAL or NTSC) and external analog and digital graphics
sources are supported. The Quantum processors also support the use of internal image files
(such as BMP, JPG, GIF, or PNG formats) or RGB computer graphics captured using the
QGE 100 Quantum Graphics Encoder.

The feature set supported by the Quantum Elite Control Software differs slightly from the
Quantum Connect Control Software. These differences are distinguished in this user guide.

NOTE: Quantum Elite Control Software is not compatible with the Quantum Connect
processor and vice versa.

Quantum Control Software ¢ Introduction 1
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Features

Features of the Quantum Control Software include:

e The user interface is organized into a series of tasks so that you can easily navigate
through them and set up the videowall.

e Avirtual canvas provides an on-screen layout for the videowall where windows can be
added, sized, and positioned.

e Custom videowall configurations can be saved as window presets for future recall.

e The software lets you create a custom user interface so that the system operator can
easily recall the presets (scenes).

Scene control

Each source is displayed in a resizable window within the Quantum Control Software,
allowing multiple sources to be placed in any position on the display.

The Quantum Control Software stores different source layouts for the display as scenes,
which are presets that include the size, position, and contents of one or more windows.
Scenes can be recalled in any order using a customizable user interface or in a predefined
order at specific time intervals using the Auto Play function (see the Creating a Project
section beginning on page 41 and the Viewing a Project section beginning on page 61).

Scenes can also be recalled remotely via RS-232 (see Serial Commands beginning on
page 70).

Quantum Control Software ¢ Introduction



Installation and
Operation

This section describes the software installation and communication setup for the Quantum
Control Software and describes the software operation. Topics include:

e Requirements

e Software Installation

e Configuring the Hardware

e Using the Quantum Control Software

Requirements

System Requirements

To ensure that the Quantum Control Software functions correctly and reliably, you must
install it on a computer that meets or exceeds the following criteria:

H Minimum | Recommended
Operating System Windows XP® Windows 7 or Windows 8
(32-bit or 64-bit)
Processor Speed 1 GHz 1 GHz or higher
Memory (RAM) 1GB 1 GB or higher
Hard Disk Free Space 30 MB More than 30 MB
Graphics 1024x768, 65K colors 1920 x 1080, 16.7M colors
(16-bit) (32-bit)
Network Card (Ethernet) 10Base-T 100BASE-T

Quantum Control Software e Installation and Operation 3



Network Requirements
The Quantum Elite and Quantum Connect use specific network ports for communication.
Ensure that these ports are accessible.

Quantum Elite
The Quantum Elite uses the following port numbers:

H Port Number Use
Control 1237 Quantum discovery (UDP)
7004 System configuration (TCP)
7005 Scene control (TCP)
7006 System events (TCP)
Media 1 and Media 2 || 5000 Multicast reception of QGE 100 data
stream (UDP)
37533 Discovery via Extron QGE 100 Computer
Screen Capture IP Encoder (UDP)
37532 Reception of QGE 100 data stream (TCP)

Quantum Connect
The Quantum Connect uses the following port numbers:

H Port Number User
Control 1238 Quantum discovery (UDP)
7007 System configuration (TCP)
7008 Scene control (TCP)
7006 System events (TCP)

Image Processing Hardware

The Quantum Control Software is used in conjunction with a Quantum Elite or Quantum
Connect videowall processor. Quantum Elite hardware consists of a 4U or 6U card frame
into which various input and output cards are installed. The Quantum Connect is available
only as a 4U frame. See the Quantum User Guide for more information about the Quantum
Elite and Quantum Connect, including connector pinouts and processing capability.

Except for defining an IP address, it is not necessary to perform any setup procedures on
the Quantum processor itself. System configuration is done through the control software.

Software Installation

To install the Quantum Control Software from the Extron Videowall Processing disc:

1. Insert the Extron Videowall Processing disc into the CD or DVD drive of your computer.
From the Windows desktop, open My Computer and select the appropriate disk drive.
Open the Quantum Connect or the Quantum Elite folder, depending on your device.
Open the appropriate software subfolder for your Quantum processor.

o~ 0D

Run the Quantum Connect_Setupvn.nnn.exe file (for the Quantum Connect) or the
Quantum Elite_Setupvn. nnn . exe file (for the Quantum Elite).

6. Follow the remaining system prompts to complete the installation.

Quantum Control Software e Installation and Operation



Configuring the Hardware

Connecting to a Quantum Elite or Quantum Connect

The computer with the installed Quantum Control Software communicates with the
Quantum via Ethernet. This can either be a direct or indirect connection, as shown in
figure 1. Connection to a single videowall processor can use either method, but multiple
videowall processors must use the indirect method (for example, via a hub).

Control Port

Ethernet 10BASE-T

RS-232
LEEsmmmEWm
Quantum Elite
Control Software Crossover Cable

Optional RS-232 Link
to Control Source Switchers Quantum Elite

Processor
Direct Connection

Control Port
/

Other Quantum Elite Processors
or Network Sources/Devices

Ethernet 10BASE-T

HUB
RS-232

LEEEEW
Quantum Elite

Control Software Straight-through
Cable

Optional RS-232 Link
to Control Source Switchers Quantum Elite

Processor
Indirect Connection

Figure 1. Methods of Connecting the Quantum Elite Control Software Computer
to a Quantum Elite Processor

e Adirect connection uses a single cable that is connected between the network port
of the computer and the Quantum Elite or Quantum Connect. You must use a crossover
cable; a straight-through cable does not work. The network port on the computer must
be capable of supporting a 10BASE-T connection as required by the Quantum.

e Anindirect connection is made via a hub, switch, or local area network, using a
straight-through cable. A crossover cable does not work. The hub or switch connected
to the computer must be capable of supporting a T0BASE-T connection as required by
the Quantum.

Extron recommends using only CAT 5 shielded twisted pair cables. A 16-foot crossover
cable is supplied with the Quantum processor.

See the Quantum User Guide for further details on cable requirements and connector
pinouts.
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Setting the IP Address of the Computer

The network port on the computer must be configured to use the same communications
protocol as the Quantum, which is TCP/IP. The computer must also be allocated an IP
address on the same subnet as the Quantum (see IP Addressing on page 95).

To change the IP address for your computer, follow the instructions provided in your
Windows program help file.

NOTE: If the computer is already connected to (and configured for) an existing network,
consult the network administrator before making any changes. In addition, you need
to be logged on with administrative rights before you can change Windows network
settings.

Testing the Ethernet Link

To test the operation of the Ethernet link between the computer and the Quantum, you can
use the Ping utility as follows:

1. Enter a ping command from your desktop.

Windows XP, 2000, and NT:
a. On the desktop, click Start > Run. The Run dialog box opens.

b. Inthe Run dialog box, type the following command:
ping nnn.nnn.nnn.nnn —t
where nnn.nnn.nnn.nnn is the IP address of the Quantum that you want to
test.

c. Click 0K or press the <Enter> key.
Windows 7:
a. On the desktop, click Start.

b. Inthe Search programs and files field at the bottom of the Start menu,
enter ping nnn.nnn.nnn.nnn —t and press <Enter>.

Windows 8:
a. Search for CMD.
b. Double-click the cmd.exe application icon.

c. Onthe command line, type the following command:
ping nnn.nnn.nnn.nnn —t
where nnn.nnn.nnn.nnn is the IP address of the Quantum that you want to
test.

d. Click 0K or press the <Enter> key. A command window opens.

One of the following response messages is displayed, indicating the state of the
communications link:

Reply from nnn.nnn.nnn.nnn: bytes=nn times=nms TTL=nn

This is the desired response, which indicates that the device at the specified
address is communicating directly. The response time value may vary according to
network traffic.

Example: If you send a ping command to a Quantum with the address
208.132.180.48, you should get a message similar to the following:
Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

Quantum Control Software e Installation and Operation




e Request timed out

There has been no response from the specified address. Either the videowall
processor is not receiving data from the computer or is not sending data back.
Check that the Quantum Elite or Quantum Connect is powered up and set to the
same address to which you sent the ping command. Also, check that you are using
the correct type of connecting cables for your setup (straight-through or crossover)
and that they are not damaged or faulty.

e Reply from nnn.nnn.nnn.nnn: Destination host unreachable,

The IP address of the computer is not in the same class as that of your Quantum
(see IP Addressing on page 95). See your Windows program help file for
instructions for changing your computer IP address.

2. To close the ping utility, press <Ctrl + C> on your keyboard or click the X button in the
upper-right corner of the command window.

Using the Quantum Control Software

Starting and Exiting the Quantum Control Software
You can run the Quantum Control Software using any of the following methods:
e Double-click the Quantum E1ite or Quantum Connect icon on the desktop.

e From the desktop, click Start > A11 Programs > Extron Electronics >
Quantum Elite (or Quantum Connect).

e Double-click a project file (the file name has a CTP extension) in Windows Explorer.

If the Access Control feature has been enabled, a Login dialog box is displayed. Select an
appropriate logon level and enter a password (see the Access Control section beginning
on page 81).

The Quantum Control Software splash screen appears for a few seconds followed by the
main application window (see Main Application Window on the next page).

You can exit the Quantum Control Software using any of the following methods:

e From the File menu, select Exit.

e (Click the button at the top right corner of the application window.

e Double-click the . icon in the top left corner of the application window, or
single-click the same icon and select Close from the drop-down menu.

If you have not saved your project, a message is displayed asking whether you want to save
any changes. Click Yes or No to close the prompt.
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Main Application Window

The Quantum Control Software application window contains the following elements:

Communications Setup

‘N

Set Up Sources

EA
S

Scene Design

Scene Control

—

EDID Minder

) 7o
M

"/

\

Remote Access Setup

]No Display Processors connected |Ready |Validation Status A

Figure 2. Elements of the Main Application Window

(A Title bar (D) Taskbar
(B) Menu bar (E) Workspace
(C) Toolbar (F) Status bar

@ Title bar — Shows the name of the currently loaded project.

© Menu bar — Provides a selection of drop-down menus to access various functions in
the Quantum Control Software. Most of the menu functions can also be performed
by buttons on the toolbars. The available menus change according to which task is
currently selected in the taskbar.

@© Toolbars — The various toolbars within the Quantum Control Software allow quick
access to the most commonly used functions within the currently selected task. Most
of these functions can also be performed using the menu bar. To hide or show a toolbar
for the current task, open the View menu and select the desired toolbar. A check mark
beside the menu option denotes that the toolbar is open in the application. You can also
click and drag open toolbars to rearrange them in the application window.
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Taskbar — Each major task within the Quantum Control Software is represented by
an icon in the taskbar. To select a task, click the appropriate button. This displays the
workspace, menus, and toolbars associated with the selected task.

The standard set of tasks includes:

e (Choose Display Processors e Scene Design

e (Choose Layout e Scene Control

e Communications Setup e Remote Access Setup
e Set Up Sources e  EDID Minder

Fewer tasks may be displayed depending on security settings.

Workspace — Each task in the taskbar has its own workspace. The workspace
contains the controls and functionality needed to complete the task.

Status bar — Shows information about the current status of the Quantum Control
Software. From the View menu, select Status Bar to hide or show the status bar.

Starting a New Project

When you run the Quantum Control Software for the first time after installation, a new
untitled project (presentation) is created with no system configuration settings (see figure 2
on the previous page).

Thereafter, you can start a new untitled project by either of the following methods:

Retain the existing system configuration (for example, to create a new project for the
same system) by one of the following methods:

e Click the D button on the main toolbar.
e From the File menu, select New.
e Press <Ctrl + N> on the keyboard.

Create a completely new project with no system configuration (for example, to make a
new project for a different system). To create a new project:

3. Exit the Quantum Control Software (see Starting and Exiting the Quantum
Control Software on page 7 for instructions).

4. While holding down the <Shift> key on the keyboard, run the Quantum Control
Software (see Starting and Exiting the Quantum Control Software). \When the
Quantum Control Software main screen opens, release the <Shift> key.

To give your untitled project a name, save it as the desired name (see Saving a Project on
page 10).

See the System Configuration section beginning on page 12 if you are creating a project
for a new system or need to make changes to the existing configuration.

See the Creating a Project section beginning on page 41 for information about placing
sources on the target display.
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Loading an Existing Project

1.

Click the ﬁ button on the main toolbar
-or-

From the File menu, select Open

-or-

Press <Ctrl + O> on the keyboard.

The Open dialog box appears.

Locate the file to be loaded and click Open.

Saving a Project

To save the current project:

1.

Click thea button on the main toolbar. You can also select Save from the File menu
or press <Ctrl + S> on the keyboard.

If the project has not been saved previously (untitled), the Save As dialog box opens,
allowing you to specify a name.

To save a copy of the open project:

1.
2.

3.

From the File menu, select Save As. The Save As dialog box opens.

In the File Name field, enter a name for the project copy. A CTP extension is
automatically appended to the file name.

Click save to save the file.

When creating a project, save your work regularly. You can also have the Quantum Control
Software automatically create backup files at regular intervals (see “Using Auto-Backup”).

Using Auto-backup

The Quantum Control Software can automatically back up your project at specific intervals.
In the event that any changes are lost before saving (such as due to a power outage), you
may be able to limit the amount of work you lost by restoring the last auto-backup file.

Setting the backup timer

1.

2.

From the Backup menu, select Setup Backup Timer. The Backup Setup Dialog box
opens.

~

(Backup Setup Dialog

Backup Interval:

IU— Hours Iﬁ Minutes ™ Disable Backup
Backup Folder:

IC: \Program Files\E xtron\Quantum Elite Browse |
| 0K I Cancel |

Figure 3. Backup Setup Dialog Box

Ensure that the Disable Backup check box is cleared to enable auto-backup.

NOTE: If you do not want to use auto-backup, ensure that the Disable Backup
check box is selected.
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5.

In the Hours and Minutes fields, enter the values to set the desired interval between
each backup.

In the Backup Folder field, enter the full path of the Windows folder where the backup
files are to be saved (by default, these are saved in the Quantum Elite or the Quantum
Connect folder)

_Or-

In the Backup Folder field, click Browse to navigate to the folder where the files are to
be saved.

Click OK.

Restoring an auto-backup file

1.

From the Backup menu, select Restore. If you made changes to the current file, you
are prompted to save the file first.

In the Save prompt, click Yes to save the current file. The Save As dialog box opens if it
is an untitled file.

- Or -
Click No to exit the current file without saving.
The Open dialog box is displayed.

NOTE: Backup files are contained within folders according to the date they were
created. The files are named with the project title and the time they were created.

Double-click the folder for the desired date to open it.
Select the backup file that you want to restore and click Open.
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System

Configuration

This section describes the four procedures or tasks associated with configuring the
Quantum Control Software to work correctly with a Quantum videowall processor. Topics
include:

Choosing a Display Processor
Layout Configuration
Communications Setup
Setting Up Sources

Defining EDID

The tasks described in this section can be completed in any order but the order in which
they are listed above is recommended. Unless otherwise stated, all configuration settings
described in this section are saved in the project (CTP) file.

Choosing a Display Processor

Before the Quantum Control Software can control a Quantum, it must detect and be
connected to the processor via the Choose Display Processors task.

I NOTE: Quantum Connect does not support the use of multiple processors.

Quantum Control Software ¢ System Configuration

12



1.

Click the Choose Display Processors button in the taskbar
(see figure 2, @), on page 8). -
The Choose Display Processors workspace opens.

[cE =l =
W oieice qunme NN, Ba=
| Eile View Detect Backup AccessControl Help

Dea o =
(=

-

IP Address: Connect: Name:
|10.13.194.5s o
IP Address: Connect:  Name:
|1u.13.1aa.131 r
IP Address: Connect: Name:
I1u.13.2m.171 o
>
¥ )
N/
Remote Access Setup o
L) T — »
No Display Processors connected [Ready |Validation Status 4

Figure 4. Choose Display Processors Workspace

[CE)
Click the Q button on the main application window toolbar (see figure 4)
- or -
From the Detect menu, select Detect.

The Quantum Control Software polls for any Quantum processors accessible via its
Ethernet port. An information panel is displayed for each processor detected, as shown
in figure 4.

Select the Connect check box to the right of the IP address of the desired processor. If
you are using more than one Quantum, connect to each one in the same manner.

NOTE: If the check box does not stay selected, this indicates that the
Quantum Control Software is unable to establish or maintain a connection (for
instance, due to a faulty cable or the Quantum processor and PC not being on the

same IP subnet).

You can disconnect from a Quantum processor by clearing its Connect check box.
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Assigning a Name to a Quantum Processor

If you are using the Quantum Control Software to control more than one processor, you
can give a name to each Quantum that easily identifies its role within the system. This is
especially useful when you are assigning processors to the target display screens.

For example, if you are using two processors driving the left and right sides of the target
display array, you can name the two processors Left and Right, respectively.

To assign a name, enter a suitable name in the Name field for the processor.
Layout Configuration

Choosing a Display Layout

The target display can be a single screen or several screens interlocked to form a larger
display area. Therefore, you need to define the layout within the Quantum Control Software.

The selected layout appears as the virtual display in the Scene Design task (see the
Creating a Project section beginning on page 41). This allows you to place sources
exactly where you want them to appear on the actual display array.

Use the Choose Layout task to choose and configure the display layout.
To choose and configure a layout:
1. Click the Choose Layout button on the taskbar.

The Choose Layout workspace opens.

Choose Layout

Screen resolution: 800 x 600

Figure 5. Choose Layout Workspace
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In the Choose Layout workspace, click the display layout diagram that matches the
arrangement of your target display screens. The currently selected layout is highlighted

with a blue background and red outline.

TIP: If the default layouts do not match your display configuration, see Designing
a New Layout on page 17 or Modifying an Existing Layout on page 18.

Right-click a dark gray screen rectangle (usually starting with the top left screen) in the
chosen layout and select Change Screen Processor IP from the drop-down list. The

following dialog box opens:

”
Set options for screen 1

Processar IP: | = Second Output
' Horizontal

Processor Type : I " Vertical
" Do not assign

Available Outputs : I LI

oK I Cancel

Figure 6. Set Options Dialog Box

From the Processor IP drop-down list, select the IP address of the processor you are
using. The Processor IP drop-down list displays all processors currently connected to
the Quantum Control Software via the Choose Display Processors task. If no processors
are listed, connect to one (see Choosing a Display Processor on page 12).

The Available Outputs drop-down list displays currently unassigned output cards (by
slot number). Select one to assign to this screen.

NOTE: There are two output channels on each output card. Selecting from the
Available Outputs list assigns the primary output (channel 1) to the screen. The
secondary output (channel 2) is assigned automatically using the Second Output
setting (see figure 7 on the next page for examples).
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Dual Channel
Vertical Configurations

14.1 | 151 13.1 14.1 15.1 TT
142 | 152 | | 132 | 142 | 15.2 o | 141
142 —O
Dual Channel
Horizontal Configurations ® Card Slot Number
151 { 152 | | 101 | 102 | 11.1 | 11.2 © Channel Number
H : @© Card Separator
i 12.1 | 122 | 13.1 | 13.2 © Channel Separator
14.1 : 14.2 :
: 141 ;| 142 | 151 | 15.2
151 : 15.2 :
Single Channel
Configurations
14.1 | 1561 12.1 13.1
141 | 15.1
Mixed
Configurations
11.1 12.1 13.1 11.1 1.2 | 121
112 | 122 | 13.2 13.1 15.1 12.2
14.1 : 14.2 | 15.1 13.2 | 141 E 14.2

Figure 7.  Example Display Layouts and Channel Configurations

In the Second Output panel, select how the secondary output should be assigned (see
figure 6 on the previous page). Choose from:

e Horizontal — The secondary output is assigned to the screen immediately to the
right of the primary output (when viewed from the front of the display).

e Vertical — The secondary output is assigned to the screen immediately below the
primary output.

e Do not Assign — The secondary output is not assigned; only the primary output is
used.

Click 0K to confirm the assignments.

NOTE: Screens that have been assigned or mapped appear with green
backgrounds in the layout diagram. Unassigned screens have gray backgrounds.

Repeat steps 3 through 7 for each remaining screen in the layout.
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Designing a New Layout

If the desired target display layout is not one of the options available by default, you can
create rectangular layouts as follows:

1. From the Layouts menu on the main application window menu bar (see figure 2, @,
on page 8), select New. The New Wall Layout dialog box opens.

Name: |2x2 WUXGA Wall

 Screen Properties

Output Mode: |wUXGA (1920, 1200) B0Hz |
Pixels: |1920 Refresh Rate (Hz): |60
ines: |1200
tines HDMI Format: IAutomalic ﬂ@
HDCP Naotification: |{3E e L,G

Mullion / Edge Blending Compensation -
Horizontal (pixzels) : I 0 jl Units: lPiHels LI

0 Vertical (pixels) : ,ﬂ 9'— Link

’ " Mullion Adjustment ¢~ Edge Blend Compensation

0K I Cancel

Figure 8. New Wall Layout Dialog Box

2. Inthe Name field, enter a name or brief description for the layout.

3. Inthe Wall layout panel, set the overall horizontal and vertical size of the target display
(measured in whole screens) by clicking the Left and Right Arrows in the Columns
field and the Up and Down Arrows in the Rows field. Alternatively, you can enter the
desired values in the Columns and Rows fields.

4. From the Output Mode drop-down list, select the desired resolution of each screen.

5. From the HDMI Format drop-down list, select whether to transmit HDMI data as part of
the digital output.

Select Automatic (the default) to automatically detect if the connection is to a
display that is compatible with HDMI.

Select DVI RGB 444 to specify that the signal does not contain the Info frame or
other ancillary data.

Select HDMI RGB 444 to force the Quantum to transmit the Info frame in the digital
output signal.

6. From the HDCP Notification drop-down list, select whether to enable or disable
HDCP Notification. If HDCP notification is enabled, the display indicates when HDCP
content restrictions are preventing a video signal from passing.

Select Enabled to display a green screen with the text HDCP Content in the
window if the connected device is not HDCP-capable and an HDCP input has been
selected.

Select Disabled to mute the window to black if the connected device is not
HDCP-capable and an HDCP input has been selected.
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7. To enable mullion compensation, select the Mullion Adjustment radio button in the
Mullion/Edge Blending Compensation panel. Mullion is the area of frame border that
exists between two displays. This area must be taken into account so that when an
image is spread across two or more displays, the image flow is not distorted.

8. If you are using projectors that support soft edge blending, select the Edge Blend
Compensation radio button and use the controls in the Mullion/Edge Blending
Compensation panel to set the required amount of overlap.

NOTES:

e The Quantum Elite compensates for the edge blend area but does not adjust
the brightness in the area.

e The Quantum Connect does not support the use of edge blended displays.

9. Select the Link check box to link the horizontal and vertical adjustment values. When
the check box is selected, the Vertical field is grayed out and equals the horizontal
value.

_Or-

If you clear the Link check box, you can enter separate values for the horizontal and
vertical adjustment.

10. Click OK to save the new layout.

Modifying an Existing Layout

1. Right-click a screen in the chosen layout and select Edit Wall Layout from the
drop-down list. The Wall Layout Properties dialog box opens.

2. Edit the various settings as needed (see Designing a New Layout on the previous
page).
3. Click 0K to save the layout.

Importing a Layout

To import display layouts from another Quantum Control Software file (with a CTP file
extension):

1. From the Layouts menu, select Import. The Import Wall Layout dialog box opens.
2. Locate the file that contains the desired layout and click Open.

NOTE: This imports all layouts from the selected file that are not already in the existing
file.

Deleting a Layout
To delete any of the display layouts that appear in the Choose Layout workspace:
1. Click on the layout to be deleted.
2. From the Layouts menu, select Delete.

NOTE: If you want to undo this operation, exit the program without saving the layout.
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Arranging Layouts

Changing the way layouts are presented in the Choose Layout workspace can be helpful if
there are a large number of layouts and you want to be able to see them more easily.

To arrange layouts:

1. From the View menu, select Arrange Layouts. The Arrange Layouts dialog box
opens.

Arrange Layouts [ ]

Columns : [2—i"
Panel Size : [WE" 2 ﬂ,

Figure 9. Arrange Layouts Dialog Box

2. Inthe Columns field, click the Up and Down Arrows or enter a value to set the number of
icon columns to be displayed.

3. Inthe Panel Size field, click the Up and Down Arrows or enter a value to set the relative
panel size for the display layout.

4. Click OK.

Restoring Default Layouts

You can restore the default layouts that were present when you first installed the Quantum
Control Software. Performing this operation deletes any user-defined layouts.

To restore a default layout, select Default from the Layouts menu.

Communications Setup
Ensure that the serial ports of the computer are correctly configured if:

e You are using the Quantum Control Software to control external devices such as source
switchers

- Or -
e You wish to remotely control the Quantum System using serial data strings.
To open the Communications Setup workspace:

Click the Communications Setup button on the main application window taskbar l
(see figure 2, @), on page 8).

The Communications Setup workspace opens (see figure 10 on the next page).
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Communications Setup

= M Devices P
=1 8 serisl Devices =
7 com Port Settings
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B L Driver Path Baud rate 19200 -
e
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Stop bits I
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Selects cument COM paort for sending (U TPUT) andvor receiving INPUT] of
zenal commands.

NOTE: Oinly one port mayp be used for INFUT and/or DUTFUT.

Use this PORT foe Cusrert Ports

[~ INPUT INFUT: INuns
[v OUTFUT outrut: [COMA

<] »

Figure 10. Communications Setup Workspace

The left side of the Communications Setup workspace contains a Devices tree, similar to
Windows Explorer. There are two main folders:

e Serial Devices — Lists any serial device drivers that are currently loaded. Alternatively,
if no device drivers are found, any available serial (COM) ports detected by the Quantum
Control Software are listed.

e Settings — Allows XML device drivers to be enabled or disabled for serial or Ethernet
control (see XML Device Drivers on the next page).

The details displayed in the main area of the workspace change according to the type of
item selected in the device tree.

Configuring Serial Ports

Any unused serial ports (serial ports not used by a device driver) are listed in the Serial
Devices folder. These can be configured manually as follows:

1. Select the appropriate port number (such as COM1 or COM3) in the Serial Devices
folder of the Devices tree. The Port Settings and Serial Commands sections appear in
the workspace.

2. Inthe Port Settings panel, adjust the various parameters as required.

3. Inthe Serial Commands panel, selecting the appropriate check box to specify whether
the port will be used for incoming (input) or outgoing (output) data.

NOTE: Only one port can be used for input data and only one for output data. The
Current Ports panel shows which ports are currently in use. You can use the same
port for both input and output data.
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XML Device Drivers

Device drivers are defined by an XML file, located in the following folder on the hard disk of
the computer:

Windows NT, XP, and 2000:

C:\Program Files\Extron\Quantum Elite\XML\Device Drivers

S or-

C:\Program Files\Extron\Quantum Connect\XML\Device Drivers
Windows 7 and 8:

C:\Program Files (x86)\Extron\Quantum Elite\XML\Device Drivers

S or-

C:\Program Files (x86)\Extron\Quantum Connect\XML\Device Drivers

Contact the Extron S3 Sales & Technical Support Hotline for further advice on creating an
XML device driver file.

To enable XML device drivers:

1. In the Settings folder of the Devices tree, click XML Driver Path. An Enable XML
Device Drivers check box appears on the right side of the workspace.

2. Select the Enable XML Device Drivers check box to load the device drivers. A dialog
box opens while the Quantum Control Software loads the drivers. Then, the driver
names appear in the Ethernet Devices and Serial Devices folders of the Devices tree.

Setting Up Sources

Each source that you need to use in a project must have a corresponding source definition
within the Quantum Control Software.

A source definition contains full details of the source, such as its signal format (NTSC, PAL,
RGB, DVI, and so on) and to which input channel on the Quantum processor the source is
connected.

If you are using an external source switcher (such as to give access to multiple sources on
one input), the source definition can also include a serial command string used to operate
the switcher. A separate source definition is required for each of the sources that can be
connected to the Quantum processor.

NOTE: You need to set up communications with a switcher before you can define any
sources selected via the switcher (see Communications Setup on page 19).

When the Quantum Control Software needs to display a particular source, it uses the
parameters in the source definition to configure the appropriate input channel for the source.

Source definitions are created and set up using the Set Up Sources task.

NOTE: The Quantum Connect Control Software does not support the use of QGE 100,
Clock, and picture source types.
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To access the Set Up Sources task:

Click the Set Up Sources button on the main application window taskbar
(see figure 2, @), on page 8). The Set Up Sources workspace opens.

Set Up Sources _
0‘ L. B Display Processors £
—| f@m) Quantum Sources A
:H o Source Name : IVideo Source 2
=4l picture
= L ;
K| QﬂGE ?g; Source Type : IVldeo
:H i [~ Switch Setting
212 Timer
e—__ 114 video Source Selected TX - l
= video Source 1 |
Q— = video Source 2 aneinrs
Id
Location
Format No Format Set
AutoDetect False
Deinterlace =
Input T7E
AlwaysOn Falos
Detect Sources b
v)
(<] ‘ ~

Figure 11. Set Up Sources Workspace

O All display processors @© Source type
©® Quantum processor @® Source definition

The source explorer tree, in the left panel of the Set Up Sources workspace, shows a list of
source types supported by the Quantum processor. Source definitions are listed under the
relevant source type. The source tree expands up to four levels as shown in figure 11. When
you open the source explorer after creating an entirely new project (or for the first time after
installation), no source definitions are listed.

Creating Quantum Source Types and Source Definitions

1. In the source explorer of the Set Up Sources workspace, right-click Display
Processors and select the desired option. Available options include:

e Create Quantum Sources — This option adds a list of the supported source types
to the source tree. Then, you need to create source definitions.

e Detect Sources — Selecting this option is the easiest method to create source
types. To detect sources, the Quantum must be connected to a PC with the
Quantum Control Software installed. The software communicates with the
processor, detects the number and type of input cards that are present, and
builds the source type list. If sources are connected to the processor, the source
definitions are also created.

e Update Sources — Selecting this option when the PC is connected to a Quantum
processor updates the source tree details.

e Remove All Devices — Deletes all devices listed under Display Processors. (If no
devices have been detected, this option is grayed out.)
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2. Right-click the appropriate source type heading in the source explorer (RGB, QGE 100,
Vvideo, and so on) and select Create New Source from the drop-down menu. An empty
source definition screen opens in the workspace (see figure 11 on the previous page
for an example of a new video definition).

3. Inthe Source Name field, enter a name for the source.

4. |If a serial string is required for the source (for instance, to operate an external switcher),
enter the appropriate control string in the Source Selected TX field.

5. Inthe Parameters panel, enter the required settings for the source. These settings vary
according to the source type and are detailed in Source Parameters on the next page.

If you click Detect Sources within a source definition, The following dialog box opens:

~
Select Quantum source
Please select a processor from the list below ta read available sources
Cornected VN Quantum Processors
IP &ddress ‘ Name
4 I I | [ )]
Click "Refresh’ to update processor list. Refresh
Avallable sources
Click on processor list refresh source hist
Source (D Farmat Status
4 l I | [ )l
Delete Al Sources

Figure 12. Quantum Source Selection Dialog Box

6. Select a source from the list and click 0K to create a source definition for it.

Deleting Source Definitions
To delete a single source definition:

1. Right-click the appropriate source definition in the source explorer and select Delete
Source from the drop-down menu.

2. Inthe Delete Source dialog box, click Yes to confirm the deletion.
To delete all source definitions:

Right-click Display Processors in the source explorer and select Remove All Devices
from the drop-down menu.

Refreshing Source Data

The DVI, HDMI, SDI, and Video source definition windows each contain a Refresh Status
button. Click this button to update the information displayed for the selected source.
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Source Parameters

This section describes source parameters for each Quantum source type, along with
functionality descriptions and available options. These parameters are displayed in the Set
Up Sources workspace when you select a source definition in the source explorer (see

figure 12 on the previous page).

Source parameters — Composite video and S-video
Click a composite video or S-video source name listed under Video to view the source

connected to a Quantum Video Input Card.

Source Name : INew Source 2

Source Type : IVideo

1~ Switch Setting

Source Selected TX : I

=
F

Id

Location

Format No Format Set

AutoDetect False

Deinterlace 1i

Input Auto

AlwaysOn False

Refresh Status

Apply

Figure 13. Video Source Parameters

Video or S-video
Source Parameter

Parameter Value

Description

Source Name

<Enter name for source>

Descriptor to identify the source

Source Type <Read-only field> Displays the type of source.

Source Selected TX <Enter RS-232 string to be (Optional) Transmits an RS-232 command to a
transmitted to a connected matrix matrix switcher.
switcher>

ID e <Enter source input number> Displays the source input number on the

e <Automatically detect source
input number>

Quantum identified by the card slot number
and card input number.

To detect this value, click the Detect Sources
button (see Creating Quantum Source
Types and Source Definitions on page 22).

For example, 5.3 is the source connected to
input 3 of the card in slot 5.
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Video or S-video
Source Parameter

Parameter Value

Description

Location e <Enter IP address> Displays the IP address of the Quantum card
e <Automatically detect IP frame where the source is connected.
address> To detect the IP address, use the Detect
Sources button (see Creating Quantum
Source Types and Source Definitions on
page 22).
Format ® <Read-only field> This parameter depends on the AutoDetect
e <Select an option from the setting.
drop-down 1ist of format types> e [f AutoDetect is set to True, this parameter
is read-only, showing the current source
format as detected by the Quantum
processor.
e |f AutoDetect is set to False, you can
select an available source format.
AutoDetect e True: Allows the Quantum processor | Enables and disables automatic detection of
to automatically detect the current the current source type.
source type.
e False: Allows you to manually select
the source type from the Format
drop-down list.
Deinterlace e 1i: Single Field Interpolation Sets the deinterlace mode to be applied to the
e 3i: Three Field Interpolation source.
See the Quantum User Guide for further
information about deinterlacing.
Input e Auto: Automatically discovers the Sets the input format.
format.
e Svideo: Forces S-video mode.
e Composite: Forces composite video
mode.
Always On e False (default): The source is not Sets whether the source is always displayed,

always displayed.

e True: The source is always displayed.

regardless of whether it is locked to a valid
sync.

When Always On is set to True, video can be
seen while VCR sources are being rewound or
fast-forwarded.
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Source parameters — RGB

Use the RGB source type to view an RGB graphics or HD video source connected to a

Quantum RGB Input Card.

Source Name : INew RGE Source 1

— Switch Setting

Source Selected T I

—Source Propertie:

Source D : |51— Detect Sources |
Source Location : |10.13.3.48

— Source Format

Format: | 10244768@E0_GTF_USER_O | r— | = |
Colour Space : IHGB j
~ Auto Detect * Manual New | Delete |
—&djustment;
il = Source Yiewporting
Brightness - I j Size Position
Cortragt: |0 i’ % Piugls - IU il H Pz |0 i’
] a - -
Phase : ZI ' Pixels : ID zl V Pos: |0 j

Pixel Clock : [0 :I

alr

Image Auto Centre : IContinuous 'l

Auto Phaze v

I Resst |
I Keep Scene Apply |
Figure 14. RGB Source Parameters

Parameter RGB Source Parameter Value Description
Group Parameter

Source Name <Enter name for source> Descriptor to identify the source
Switch Source Selected | <Enter RS-232 string to be (Optional) Transmits an RS-232
Setting > transmitted to a connected matrix command to a matrix switcher.

switcher>

Source Source ID e <Enter source input number> Displays the slot and channel
Properties e <Automatically detect source number of the RGB card in the

input number>

Quantum frame.

To detect this value, click the
Detect Sources button (see
Creating Quantum Source
Types and Source Definitions on
page 22).

For example, 5.3 is the source
connected to input 3 of the card in
slot 5.

Source Location ||® <Enter IP address>

e <Automatically detect IP
address>

Displays the IP address of the
Quantum card frame where the
source is connected.

To detect the IP address, use

the Detect Sources button (see
Creating Quantum Source Types
and Source Definitions).
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Parameter RGB Source .
Parameter Value Description
Group Parameter
Source Format ® <Read-only field> This parameter depends on the
Format AutoDetect setting.

® <Select an option from the
drop-down 1ist of format types>

e [f AutoDetect is selected, this
parameter is read-only, showing
the current source resolution
as detected by the Quantum
processor.

e |f AutoDetect is not selected

(radio button is cleared), you can
select an available source format.

Colour Space

e RGB (default): Default mode

e Component HD: Option for component
HD inputs

e Component SD: Option for component
SD inputs

Lets you select the required color
space.

Auto Detect

® True (select Auto Detect radio
button): Allows Quantum processor to
automatically detect the current source
type.

* False (select Manual radio button):

Allows you to manually select the
source type from the Format
drop-down list.

Enables and disables automatic
detection of the current source
format.

Manual ® True (select Manual radio button): When this mode is enabled, the
Allows you to manually select the input mode can be forced to a
source type from the Format known format.
drop-down list. In addition, new custom input

e False (select Auto Detect radio modes can be built (see Creating
button): Allows the Quantum a custom input mode on the next
processor to automatically detect the | page).
current source type.

Adjustments | Brightness, <Enter values for brightness and Adjusts the brightness and contrast

Contrast contrast> of a source

Phase, Pixel <Enter values for phase and pixel Adjusts the sample clock

Clock clock> parameters.

Ensure that the Auto Phase check
box is not selected.

Auto Phase e <Select Auto Phase check box>: Enables and disables automatic

Enables Auto Phase and adjusts the
clock phase automatically.
® <Clear Auto Phase check box>:

Disables Auto Phase.

adjustment of clock phase.
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Parameter RGB Source .
Parameter Value Description
Group Parameter
Source X Pixels, Y <Enter values for size (X pixels These controls allow a section of the
Viewporting | Pixels, and Y pixels) and position (H pos captured source to be isolated as a
H pos, V pos and V pos). viewport. There is only one viewport
for each input channel.
Image Auto e 0ff: No automatic centering Sets whether to automatically center
Centre e Once: Centers source image as part the input source image and at what
of the Detect process frequency.
e Continuous: Continually monitors
and centers input source
Keep Scene <Select Keep Scene check box>: Sets whether to display the current

Displays the current scene, not the
source.

<Clear Keep Scene check box>:
Displays the source on output 1.1.

scene or the source.

Creating a custom input mode

To create custom input formats for RGB sources in the Set Up Sources workspace:

1. In the source explorer on the Set Up Sources workspace, select an RGB source (or
create a new RGB source type and definition (see Creating Quantum Source Types
and Source Definitions on page 22). The definition screen for the selected source
opens in the workspace (see figure 11 on page 22 for an example).

2. Inthe Source Format panel, select the Manual radio button (see figure 14 on page 26).
This disables Auto Detect mode and lets you choose a known source format.

3. From the Format drop-down list, select the resolution to use as a starting point.
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4.

In the Source Format panel of the RGB Set Up Sources dialog box (see figure 14 on
page 26), click New. The User Custom Input Mode dialog box opens.

‘

(User Custom Input Mode

Mode Name : |1 024x768@E0_DMT_USER_D

Template Format : | 10244768@60_DMT [~
Colour Space : IHGB LI
[~ Active Area

Active Lines : 768 j’

Active Pizels : 1024 ﬂ First Active Line : 35 ﬂ
Total Pizels : 1344 ﬂ First Active Pixel : 236 ﬂ

[~ Signature P.

S I a0~ These parameters should only be
Total Lines : =1 modified if absolutely necessary to
. . ) _+| produce a required image as they may
Line Period {us): | 20677 | affect the reliability of the auto detect

feature.
WSync Lines : I 6 ilj

Sync Polarity : |H-.V- Ll Interlaced [

| 0K I Cancel | Apply |

Figure 15. User Custom Input Mode Dialog Box

In the Mode Name field of the User Custom Input Mode dialog box (see figure 15), enter
a name for the custom mode.

From the Template Format drop-down list, select the desired template for the
customized format (this should already be selected).

From the Colour Space drop-down list, select the color space to use (such as RGB,
Component SD, or Component HD).

In the Active Area panel, adjust the settings as needed by manually entering values into
the appropriate fields. Alternatively, click the Up and Down Arrows to adjust the values.
You can adjust the following settings:

Active Lines Active Pixels Total Pixels
First Active Line First Active Pixel

In the Signature Parameters panel, adjust the following settings if needed:

Total Lines Line Period VSync Lines
Sync Polarity Interlaced check box
ATTENTION:

e Adjust the parameters in the Signature Parameters panel only if absolutely
necessary to produce the required image. Changes to these settings may
affect the reliablility of the Auto Detect feature.

e Réglez les parameétres dans la section Parameétres de Signature, seulement
s’il est absolument nécessaire de montrer I'image requise. Changer ces
parameétres peut affecter la fiabilité de la fonction « Détection Automatique ».

10. Click Apply to save the changes and continue making other modifications. Alternatively,

click 0K to save the changes and close the User Custom Input Mode dialog box.
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Editing an input mode

To adjust the settings of custom input modes and existing factory formats:

1.

© a0, Db

Within the source explorer of the Set Up Sources workspace, select an RGB source (or
create a new RGB source type and definition (see Creating Quantum Source Types
and Source Definitions on page 22). The definition screen for the selected source
opens in the workspace.

In the Source Format panel, ensure the Manual radio button is selected.
From the Format drop-down list, select the format to be modified.

Click Edit. The User Custom Input Mode dialog box opens.

Adjust the settings as necessary.

Click Apply to save the changes and continue making other modifications. Alternatively,
click 0K to save the changes and close the User Custom Input Mode dialog box.

NOTE: When adjusting input modes provided with this application, you are making

changes to the original factory formats. Any changes made cannot be undone.

Deleting a custom input mode
To delete a custom format:

1.

In the source explorer on the Set Up Sources workspace, select an RGB source (or
create a new RGB source type and definition (see Creating Quantum Source Types
and Source Definitions). The definition screen for the selected source opens in the
workspace.

In the Source Format panel, ensure that the Manual radio button is selected.
From the Format drop-down list, select the format to be deleted.

Click Delete. The format is removed from the Format drop-down list and the No
Format Set option is selected.

Quantum Control Software ¢ System Configuration 30



Source parameters — DVI

Use the DVI source type to view a source connected to a Quantum DVI Video Input Card.

Source Name : IDVI 21

Source Type : ID\"

~ Switch Setting

Source Selected TX : |

Parameters

Id 21

Location 10.13.198.131

Format

Detect Sources

Refresh Status Apply

Figure 16. DVI Source Parameters

DVI Source
Parameter

Parameter Value

Description

Source Name

<Enter name for source>

Descriptor to identify the source

Source Type <Read-only field> Displays the type of source
Source Selected TX <Enter RS-232 string to be (Optional) Transmits an RS-232 command to a
transmitted to a connected matrix matrix switcher.
switcher>
ID e <Enter source input number> Displays the source input number on the
e <Automatically detect source Quantum identified by the card slot number
input number> and card input number.
To detect this value, use the Detect Sources
button (see Creating Quantum Source
Types and Source Definitions on page 22).
For example, 5.2 is the source connected to
input 2 of the card in slot 5.
Location e <Enter IP address> Displays the IP address of the Quantum card
e <Automatically detect IP frame where the source is connected.
address> To detect the IP address, use the Detect
Sources button (see Creating Quantum
Source Types and Source Definitions).
Format <Read-only field> Reports the source resolution as detected by

the Quantum processor.
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Source parameters — HDMI
Use the HDMI source type to view a source connected to an HDMI Video Input Card.

Source Name : IHDM| 31

Source Type : IHDMl

~ Switch Setting

Source Selected TX: I

~ Parameters
Id 3.1
Location 10.13.198.131
Format 1280x720@E0
HDCP Status Unencrypted
HDCP Authorized On

Detect Sources Refresh Status Apply

Figure 17. HDMI Source Parameters

HDMI Source Parameter Value Description

Parameter

ID e <Enter source input number> Displays the source input number on the

e <Automatically detect source Quantum identified by the card slot number
input number> and card input number. For example, 5.2 is the
source for input 2 of the card in slot 5.
To find this value, click the Detect Sources
button (see Creating Quantum Source
Types and Source Definitions on page 22).
Location e <Enter IP address> Displays the IP address of the Quantum card
e <Automatically detect IP frame where the source is connected.
address> To detect the IP address, click the Detect
Sources button.

Format <Read-only field> Reports the source resolution as detected by
the Quantum processor. Click the Refresh
Status button to update this field.

HDCP Status <Read-only field> Reports the input HDCP encryption status.
Click the Refresh Status button to update
this field.

HDCP Authorized e 0n: Outputs do not display content if Lets you select whether to enable or disable

the system is not fully HDCP-compliant | HDCP authorization if the system is not fully

e Off: Video is displayed on all outputs HDCP-compliant and digital sources need to
despite the system not being fully be displayed on all outputs.
HDCP-compliant
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Source parameters — SDI

Use the SDI source type to view a source connected to an SDI Video Input Card.

Source Name : ,SDI 4.2

Source Type : ISD|

~ Switch Setting
Source Selected TX : I
Parameters
Id 4.2
Location 10.13.198.131
Format No Format Set
Film Mode Automatic
Deinterlace Enabled
Detect Sources | Refresh Status Apply

Figure 18. SDI Source Parameters

SDI Source Parameter Value Description
Parameter
ID ® <Enter source input number> Displays the source input number on the
o <Automatically detect source Quantum.identified by the card slot numbgr
input number> and card mput number. For egample, 4.2 is the
source for input 2 of the card in slot 4.
To find this value, click the Detect Sources
button (see Creating Quantum Source
Types and Source Definitions on page 22).
Location e <Enter IP address> Displays the IP address of the Quantum card
o <Automatically detect IP frame where the source is connected.
address> To detect the IP address, click the Detect
Sources button.
Format <Read-only field> Reports the source resolution as detected by
the Quantum processor. Click the Refresh
Status button to update this field.
Film Mode e Automatic: Detects the presence of a | Lets you enable or disable automatic film
film mode cadence (default). mode detection (PAL, NTSC, and 1080i).
e Disabled: No film mode detection is
performed.
Deinterlace e Enabled: Deinterlaces NTSC, PAL, Selects whether sources are deinterlaced

and 1080i sources (default).
Disabled: Deinterlacing is not done.

before being placed on the RAPT bus.
Selecting Disabled saves bandwidth on the
RAPT bus when deinterlacing is not a priority.
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Source parameters — QGE 100

Use the QGE 100 source type to display a source derived from a QGE 100.

I NOTE: The Quantum Connect does not support the use of QGE 100 sources.

Saurce Name : |New 0OGE 100 Source 1

Source Type: IQGE 100

— Switch Setting

Source Selected T I

— Parameter

Server

IP&ddress

Multicast Address

Multicast Port 5000

Detect Sources |

Apply |

Figure 19. QGE 100 Source Parameters

QGE 100 Source
Parameter

Parameter Value

Description

Source Name

<Enter name for source>

Descriptor to identify the source

Source Type <Read-only field> Displays the type of source
Source Selected TX || <Enter RS-232 string to be This is optional. Transmits an RS-232
transmitted to a connected matrix command to a matrix switcher.
switcher>
Server <Enter name or IP address of host or | Specifies the network name* or IP address of
source computer> the QGE 100 source
*To use names, the network must support
DNS (Dynamic Name Services).
For example, to select a QGE 100 source
called “QGE100” with an IP address of
178.28.229.101, enter either QGE100 or
172.28.229.101.
IPAddress <Enter IP address> Displays the IP address of the QGE 100 where
the source is connected.
This field must be left blank if the adapter
is using DHCP.
Multicast Address <Enter multicast address of the If the source is a QGE 100 operating in

connected QGE 100>

Multicast mode, enter its multicast address
here.

For example, enter 234.5.6.183.

Multicast Port

<Enter multicast port number of the
connected QGE 100>

The default port is 5000.
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Source parameters — Picture

Use the Picture source type to display an image file (in JPG, GIF, PNG, or BMP format). The
file can be on the Quantum hard drive (in the d: /pictures folder) or on the network.

I NOTE: The Quantum Connect does not support the use of Picture sources.

Source Mame : INew Picture Source 1

Source Type : IF'iCtU'e

— Switch Setting

Source Selected Ti I

— Parameter

Filenarne [filename]

Location

GraphicsOwerlay Falze

2550255

KepColour

Detect Sources | Apply |
Figure 20. Picture Source Parameters
Picture Source oL
Parameter Value Description

Parameter

Source Name

<Enter name for source>

Descriptor to identify the source

Source Type <Read-only field> Displays the type of source
Source Selected TX || <Enter RS-232 string to be This is optional. Transmits an RS-232
transmitted to a connected matrix command to a matrix switcher.
switcher>
Filename <Enter path and filename of the Indicates the path and filename of the desired
desired image> image. For example:
e To select a file on the Quantum, use the
format d: /pictures/companylogo. jpg
e To select a file on a network computer or
server, use the format:
\\imageserver\companylogo. jpg
Location e <Enter IP address> Displays the IP address of the Quantum
e <Automatically detect IP card frame where the image file is located.
address> To detect the IP address, use the Detect
Sources button (see Detect Sources on
page 22).
GraphicsOverlay e True: Makes the specified key color in | Makes the specified key color transparent or
the image transparent. opaque.
® False: Disables transparency (key
color is opaque).
KeyColour <Enter three values each, @ to 255> | e If GraphicsOverlay parameter is set to

True, these values set the color in the
image that will be transparent.
Example: @, @, 255 = Blue

e |f Graphics Overlay is set to False: these
values set the red, geen, and blue levels.
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Source parameters — Timer

Use the Timer source type to create an on-screen clock or count-down or count-up timer.

I NOTE: The Quantum Connect does not support the use of Clock or Timer sources.

Source Name ; |New Timer Source 1

Source Type : |Timer

Switch Setting

Source Selected Tk |

Parameters

Id

Graphics0wverlay

Falze

Size

Medium

ForeColour

255,256,255

BackColour

0.0.0

Fant

Werdana

TimeF ormat

24

ShowsS econds

True

ShowD ate

True

D ateFormat

dd/mmy

Showta/eekDay

True

TimerStartTime

00:00:00

ClackMaode

Clock

TimeZone

[GMT] Greenwich Mean Time : Dublin, Edinburgl

Alignment

Center

TimerCountDirection

Up

Apply
Figure 21. Timer Source Parameters
Timer Source Parameter Value Description

Parameter

Source Name

<Enter name for source>

Descriptor to identify the source

Source Type

<Read-only field>

Displays the type of source

Source Selected TX

<Enter RS-232 string to be
transmitted to a connected matrix

This is optional. Transmits an RS-232
command to a matrix switcher.

switcher>
ID <Enter an alphanumeric label> User-defined alphanumeric label (such as the
source name) that is unique to the project
GraphicsOverlay e True: Makes the specified background | Makes the background color of the image
color in the image transparent. transparent or opaque.
® False: Disables transparency
(background color is opaque).
Size e Small Sets the size of text on the clock or timer

e Medium (default)
°* Large
°* ExtralLarge

display.
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Timer Source

Parameter Value

Description

Parameter
ForeColour <Enter three values each, from@ to | Sets the foreground (text) color for the clock or
255> timer display. These values set the red, green,
and blue levels. For example:
e 255,255,255 = White (default)
e 128,0,0 = Mid-red
e 255,255,0 = Bright yellow
BackColour <Enter three values each, from@ to | Sets the background color for the clock or
255> timer display. These values set the red, green,
and blue levels. For example:
* (,0,0 = Black (default)
e 128,0,0 = Mid-red
e (,0,75 = Dark blue
Font e Arial Sets the font for the clock or timer display
e Verdana (default)
® Microsoft Sans Serif
° Tahoma
TimeFormat e 12: Sets 12-hour time format. Sets the time format for the clock or timer
o 24 (default): Sets 24-hour time format. | display
ShowSeconds e True: Displays hours, minutes, and Displays or hides the seconds in the time.
seconds.
e False: Displays only hours and
minutes.
ShowDate e True: Displays the date and time. Sets whether to display the date along with the
e False: Displays only the time. time.
DateFormat e dd/mm/yyyy (default) Sets the format to use when displaying the
e mm/dd/yyy date.
° 20 June 2006
* June 20 2006
ShowWeekDay e True: Displays the day of the week Sets whether to display the day of the week
(Monday to Sunday) and the date along with the date.
e False: Displays only the date
TimerStartTime <Enter the time from which the timer |When the Quantum is operating in timer mode,
begins> this value defines the start time in hh:mm:ss.
The default is 00 : 00 : 00.
In countdown mode, when the timer reaches
zero, the timer reloads with the preset value
and starts again.
ClockMode e Clock (default) Selects a standard clock or a timer to display.

® Timer

For timer mode, set the TimerCountDirection
parameter as needed.
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Timer Source Parameter Value Description

Parameter

TimeZone <Select an option from the drop-down | Sets the time zone for the clock and date.
list of time zones> -

NOTE: The time zone that was set on the
control software PC must match the time
zone set on the Quantum card frame.
The default is Greenwich Mean Time
(GMT), London.

Alignment o Left Sets the horizontal alignment of the text
e Center (default) relative to the window in which it is placed.
e Right

TimerCountDirection | Up (default) When using timer mode, use this parameter to
e Down set the direction in which the timer will count.

Defining EDID

EDID information (display resolution, refresh rate, and pixel clock rate), when read from an
output display or selected by a user, is stored in memory on each input, allowing the source
to perform as if connected to the display, even when it is not.

The EDID Minder screen enables you to set the Extended Display Identification Data
(EDID) for each of the RGB, DVI, and HDMI inputs on the cards installed in your Quantum
processor. It also provides status on the current EDID resolution that has been set for each
input. The default EDID setting of 1920x1200 at 60 Hz is used for each input.

Selecting an EDID
To specify a display EDID for an input (see figure 22 on the next page):
1. Click the EDID Minder icon on the taskbar (see figure 2, @), on page 8).

2. Inthe EDID Minder workspace (right panel), click the Refresh Status of
Input EDID button. The installed input connectors are displayed in the input
channel list (left column).

You can sort the input channels on this list by signal type (DVI, HDMI, and RGB),
connector ID, EDID currently assigned to the input, or IP address of the Quantum
(Location). Click the desired column heading to toggle between sorting and inverse
sorting.

3. On the channels list, select an input by clicking on its signal type to highlight it. To select
multiple individual inputs, hold down <CTRL> while clicking each one. To select a group
of consecutive inputs, hold down <Shift> while selecting the first and last input in the
range.
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4. From the Select EDID Resolution drop-down menu, select the EDID to apply to the
selected input. The menu contains the following resolutions at 50 Hz and 60 Hz.

Use Display’s EDID* 1280x768 1400x10590
649x480 1280x800 1680x1050
800x600 1280x1024 1600x1200
848x480 1360x768 1920@x1080 (1080p)
1024x768 1366x768 1920x1200
1280x720 (720p) 1440x900

*This option does not appear on the menu unless an EDID has been captured from
display 1 (see Capturing an EDID (HDMI Displays Only) on the next page.

|[B® HDMI input test.ctp - Quantum Elite
File View Backup AccessControl Help

nN&d R

Type l Id I Current EDID I Location I
A DVI 1920x1200 @ 60Hz* 10.13.194.59

A& DVI 1920x1200 @ 60Hz* 10.13.194.59

A DVI 1920x1200 @ 60Hz* 10.13.194.59

A DVI 192051200 @ 60Hz* 10.13.194.59 Select EDID Resolution:

A DVI 1920x1200 @ 60Hz* 10.13.194.59 -
A DVI 1920x1200 @ 60Hz* 10.13.194.59
&% HOMI 1920x1080 @ 50Hz 10.13.194.59
&% HOMI 1920x1200 @ 60Hz 10.13.194.59 Apply to Selected
WE$HOMI 1920x1200 @ 60Hz 10.13.194.59
&% HOMI 1920x1200 @ 60Hz 10.13.194.59

Refresh Status of Input EDID I

Preferred Timing of Captured EDID:

NZ&

Capture EDID from display #1

Note: Display EDID can only be captured from displays
connected to an HDMI output card.

E[;lD Mnderﬂ

Connected to: 10.13.194.59 |Scene delay = 100.00% of scene setting |Validation Status

Figure 22. EDID Minder Screen

5. Click Apply to Selected. The new EDID appears in the input channels list for the
selected input.
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Capturing an EDID (HDMI Displays Only)

An alternative method of assigning an EDID to an input is to “capture” the EDID information
from the output to which display 1 is connected.

NOTE: Display 1 is the display located at the top left of your selected layout. Click the
Choose Layout icon on the taskbar to view the current layout.

For this procedure, display 1 must be connected to a Quantum HDMI output card.

To capture and apply the EDID of display 1 to an input:

1. Click the Capture EDID from display #1 button in the EDID Minder workspace. The
display 1 EDID is displayed in the Preferred Timing of Captured EDID box above the
button.

2. Select an input from the input channels list.
3. From the Select EDID Resolution drop-down menu, select Use Display’s EDID.

NOTE: This selection may not be available the first time you perform this procedure.
If it does not appear on the menu, skip this step. The option is added to the menu
and appears in the Select EDID Resolution box after you capture and apply the
display 1 EDID.

Example: In figure 23, HDMI input 5.2 has been selected on the input channels list and
Use Display’s EDID has been selected from the Select EDID Resolution menu. The
captured display 1 resolution of 1920x1200 @ 60 Hz appears in the Preferred Timing of
Captured EDID box. The Apply to Selected button has not yet been clicked, so the
selected input is not shown with the captured EDID.

Type I Id | Current EDID | Location |

A DVI 21 1920x1080 @ 60Hz 101319459

A DVI 22 1920x1200 @ 60Hz* 10.13.194.59 Refresh Status of Input EDID |
A DVI 31 1920:d200 @ 60Hz* 101319459

A DVI 32 1920x1200 @ 60Hz* 10.13.194.59 Select EDID Resolution:

A DVI 41 1920:200 @ 60Hz* 10.13.194.59 v
A DVI 42 1920x1200 @ 60Hz* 10.13.194.59

&% HoMI 51  1920x1080 @ 50Hz 101319459

&% HoMI 52 1920x1200 @ 60Hz 10.13.194.59 Apply to Selected |
&% HOMI 61 19201200 @ 60Hz 101319459

&% HomI 6.2 1920x1200 @ 60Hz 10.13.194.59

Preferred Timing of Captured EDID:

1920x1080 @ E0Hz

Capture EDID from display #1

Note: Display EDID can only be captured from displays
connhected to an HDMI output card.

Figure 23. Capturing the EDID of Display #1

4. Click Apply to Selected. The captured EDID of display 1 appears beside the selected
input on the input channels list.

NOTE: On the EDID Minder input channels list, the asterisk (*) following an EDID
indicates that the EDID was captured.
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Creating a Project

This section describes the Scene Design task and creating a project using scenes and
windows. Topics that are covered include:

e Working with Scenes
e Working with Windows

Working with Scenes

A scene is a preset that contains the size, position, and contents of one or more windows.
You can create scenes, save them, and recall them to display.

Scene Design Task

¢

B QUANTUM2X3 ctp - Quantum -
File View Grid Window Sceje Auto Play §ackug Access Cont uelp _ _ i 7 - |
| ‘ D g g ‘ m X E% Eii Q Q -ﬁ m D !i n @g @ @ HPosmor; VPosmong Wldlh: Helght: ‘M

| (i)

=100 (c)
I | =-dg Sources Scenel

e-4E| ov1 Scene 2
Scene 3
Scened
Scene5

|

CONSOLE PC - = GSS1
> -8 GsS2
-
= Cowouere
= Scene7
- HD PLAYER Scene8
.. pC1 TEST
= PQ22 =
]
=4l rReB
.. = GSS3
.. = GSS4
.. GSS5
... GSS6
=4l Video
-3 DVD1
.= DVD2
= pvD3
= New Source 92
= Sp1
= Sp2
= Sp3
= SD4
= SD5
= SD6
= Sp7

SECEED ER

I Connected to: 10.13.201.171(10.13.198.20 Disconnected) |Scene delay = 100.00% of scene setting |Validation Status 4

|

Figure 24. Main Features and Toolbars of the Scene Design Task

@ Virtual Display toolbar @ Window Properties toolbar @ Virtual display area
® Window toolbar @ Window palette @ Scenelist

@® Scene toolbar @ Source Explorer @ Scene Control toolbar
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To view a source on the target display, place a window (containing the appropriate source)
on the display. Windows and scenes are created and edited in the Scene Design task. You
can store the size, position, and contents of one or more windows as a scene. Each scene
can have a different arrangement of windows and sources.

To open the Scene Design task: _
1. Click the Scene Design button on the taskbar (see figure 2, @, on page 8). s ;

The Scene Design Workspace opens (see figure 24 on the previous page).

Creating a New Scene

New scenes are added to the end of the scene list. A new scene has no attributes copied
from the currently selected scene.

NOTE: The number of windows allowed within a scene depends on the Quantum

processor hardware. The maximum is 128 windows per output card. See the Quantum
User Guide for more details.

To create a new scene:

1. Click the @ button on the Scene Properties toolbar (see figure 24, (). The Scene
Properties dialog box opens.

- ™

Scene Properties
Post Scene Commands I Exit Scene Commands
Properties | Pre Scene Commands

Scene Title:
Scene 2
Auto Play Delay [mSec): 51 000

Include Scene Ih Autaplay v

Diont display windows - send zerial stings only [

ak. I Cancel |

Figure 25. Scene Properties Dialog Box

2. Modify the default scene title as desired. To change other settings follow the procedure
described in Changing Scene Properties on the next page.

3. Click oK. In the Scene Control workspace, a new Scene Selection button is also
added for the new scene (see Using the Scene Control on page 61).

4. Add a window to the scene (see Adding Windows to the Window Palette on
page 48).
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Copying an Existing Scene

You can create an exact copy of any scene that exists in your project. This is useful when
you are creating a number of scenes that only have slight variations from each other.

The copied scene is inserted immediately after the original scene. It has the same window
palette, window layout, control commands, and Auto Play settings as the original.

To copy an existing scene:

1. In the scene list of the Scene Design workspace, select the name of the scene to be
copied.

2. Click the @ button on the Scene Properties toolbar. The Scene Properties dialog
box opens for the copied scene (see figure 25 on the previous page).

3. Modify the default scene title and other settings as needed.

4. Click OK. In the Scene Control workspace, a new Scene Selection button is also
added for the copied scene (see Using the Scene Control on page 61.

Deleting a Scene

1. Inthe scene list of the Scene Design workspace, select the scene to be deleted. The
selected scene is displayed in the workspace.

2. Click the Jﬂ button on the Scene Properties toolbar. In the Scene Control, the
corresponding Scene Selection button is also deleted (see Using the Scene
Control).

Changing Scene Properties

1. Select a scene in the scene list of the Scene Design workspace and click the
button on the Scene Properties toolbar

- Or -
For any scene, right-click the scene title in the scene list.
The Scene Properties box opens (see figure 25).

2. Modify the settings as needed. These settings include:

e AutoPlay Delay (mSec) — Set the amount of time that the scene is displayed
during Auto Play (see Changing the Display Time for a Scene on page 68).

e Include Scene in Autoplay — Select this check box to include this scene in an
AutoPlay project. Clear this check box to exclude the scene (see Changing the
Display Time for a Scene).

e Don't display windows - send serial strings only — By selecting the Don’ t
display windows check box on the Scene Properties dialog box, only the
serial strings (if any) associated with the scene are executed. Any source or layout
changes in the scene are ignored. This allows the scene to transmit a serial
command without changing the current layout of the target display, such as to
operate an external source switcher.

3. Click oK.
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Scene Commands

Adding a scene command

1. Sele

ct a scene in the scene list of the Scene Design workspace and click the

button on the Scene Properties toolbar (see figure 24, @, on page 41)

_Or_

For any scene, right-click the scene title in the scene list.

The

Scene Properties dialog box opens (see figure 25 on page 42).

2. Select the appropriate Scene Commands tab. The available tabs include:

Pre Scene Commands — Commands that occur as soon as the scene is selected
but not yet fully displayed

Post Scene Commands — Commands that occur when the scene display is fully
complete

Exit Scene Commands — Commands that occur when another scene is selected
but before the pre-scene commands of the new scene

NOTE: The procedure to add, edit, or remove commands is the same for each tab.

3. Click Add to display the Add Command box.

Add Command

-

Device : IDUTF’UT ;1

— Command String -

Please type in command string to be sent to attached device.

Cancel | QK I

Figure 26. Add Command Dialog Box

4. From the Device drop-down list, select the device for which you want to add a
command.

5. Inthe Commands panel, select the desired command name from the list.

If you select a non-XML defined serial port (which is shown on the Device list as

ouT
6. Clic

PUT), a text box is displayed for you to enter a free format text string command.

k OK to add the command to the scene.
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Changing the order of scene commands

Select a scene in the scene list of the Scene Design workspace and click the
button on the Scene Properties toolbar (see figure 24, @, on page 41)

-or-
For any scene, right-click the scene title in the scene list.

The Scene Properties dialog box opens (see figure 25 on page 42).
Select the appropriate Scene Commands tab.

In the command list, select the command to be moved.

In the Command Ordering panel, click the Move Up or Move Down button to move the
command to the desired position in the list.

Removing a scene command

Select a scene in the scene list of the Scene Design workspace and click the
button on the Scene Properties toolbar (see figure 24, @)

-or-
For any scene, right-click the scene title on the scene list.
The Scene Properties dialog box opens (see figure 25).
Select the appropriate Scene Commands tab.

In the command list, select the command to be removed.
Click Remove.

Editing a serial (output) scene command

© a0, Db

Select a scene in the scene list of the Scene Design workspace and click the
button on the Scene Properties toolbar

-or-
For any scene, right-click the scene title in the scene list.
The Scene Properties dialog box opens (see figure 25).
Select the appropriate Scene Commands tab.

In the command list, select the output name.

Click Edit.

Edit the free format text string as needed.

Click OK.
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Changing the Order of Scenes and Scene Navigation

You can change the order of the scenes in the scene list. When using the Auto Play option,
scenes are recalled in the order that they appear in this list. You can use the Scene Control
toolbar, scene list, and keyboard to navigate to the scene you want to view or edit. To move
a scene in the scene list, drag and drop the scene title to a new position in the scene list
(see figure 24, @, on page 41).

To go to... ‘ Click...

A specific scene The scene title in the scene list

The next scene
The B9 button or press the <Down Arrow> key on the keyboard

The previous scene
The B8 button or press the <Up Arrow> key on the keyboard

The first scene
The S |, tton or press the <Home> key on the keyboard

The last scene
The [, button or press the <End> key on the keyboard

The Play button E plays all the scenes in order in a loop until the Stop E button is
clicked.

Working with Windows

In the Scene Design workspace, the target display is represented by the virtual display area
and each window that can be placed on the display is represented by a virtual window (see
figure 24, ). Each window that appears on the display has a source associated with

it. On the Scene Design page, you can create windows and add them to the display as
desired. The contents of each window can be the same or can differ between scenes.

When you create a window, it is added to the window palette, located between the taskbar
and the source explorer panels on the Scene Design page. You can drag windows from the
palette to the Scene Design workspace and place them where desired on the display.

NOTE: The window palette may not be visible when you open the Scene Design
workspace. To display it, drag the left edge of the source explorer panel to the right
until the palette appears.
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Each virtual window has a unique number (automatically assigned by the Quantum Control
Software) and a user-definable label that is typically used to identify the source.

A)

?
deo Source 2

Figure 27. Virtual Window with Label
@ Window number
@ Window label

The appearance of a window in the window palette differs depending on whether the
window is docked (not used in the scene) or undocked (used in the scene). If the window
is undocked, it has a light gray border (see figure 28). All windows that have been added to
the virtual display have this border. Docked windows exist only in the window palette.

Dacked Undocked

B =

{The image is smaller and
has a light gray border).

Figure 28. Docked and Undocked Windows in the Window Palette

When you hover the mouse pointer over a window in the palette, a pop-up opens showing
the window number and its source type. For example:

Scene Design
New Source 1 ... W New
Bl Window 1 ”
Layer0 -
Source: New Sourcel| |
=7 TvcW
- 3 New

Figure 29. Window Details Pop-up
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Adding Windows to the Window Palette

When you create a new project, the window palette is empty and you need to add windows
to it. The methods of adding windows are described in the following sections.

Creating a window with a source

This method is the simplest and therefore recommended. To create a window with a source
displayed:

1. Click on a source name in the Source Explorer tree and drag it to the desired location in
the virtual display area (see figure 24, @, on page 41). A window with the source
selected appears in the workspace and on the palette. The size of the window matches
the current grid spacing.

NOTE: Windows created by this method appear in the workspace and
on the window palette with the source icon (shown at right) because =
they already have sources selected. t

2. Resize or move the window on the palette as desired (see Moving and Resizing a
Window on page 50.

Creating an empty window

If you have not determined the source you want to display in a window, or the source has
not been added to the Source Explorer, you can create an empty window and add the
source to it later (see Adding or Changing a Source for a Window on the next page).

You can create a window without a source in either of the following areas:

e Window palette: Right-click anywhere in the window palette, then click the Add
Window pop-up. A new window is added to the window palette and is given the next
available window number.

e Virtual display: Right-click anywhere in the virtual display or workspace (but not in an
existing window), then select Add Window from the drop-down menu. A new window is
both added to the window palette and placed in the workspace area.

Initially, each window created by this method has a pink background (see figure 29 on the
previous page), which indicates that no source is selected for the window.

Adding a Docked Window to a Scene
To add a docked window in the window palette to a scene:

1. Inthe window palette, select the window to be added to the current scene. The window
is outlined in red.

2. Drag the window into the virtual display area. The light gray border is added to the
window on the window palette.

3. Modify the window as desired (see Selecting the Window Style (Quantum Elite
Models Only) on page 52).
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Adding or Changing a Source for a Window

To select or change a source for a window on the virtual display, use one of the following
procedures.

Right-clicking and dragging: In the Source Explorer, right-click on the desired source
and drag it onto a window in the virtual layout (see figure 24, @, on page 41).

If the window already has a source, the source you are dragging replaces it. If the
window has no source, the selected source is added to it. A light gray border appears
around the window on the window palette to indicate that it has a source.

Using the Quantum Sources window:

1. Select a window in the window palette or in the virtual display area of the currently
selected scene.

2. Right-click the selected window and select Window Source from the drop-down
menu. The Quantum Sources dialog box opens.

“ Quantum Sources
View by: | Show 4l ~| Search
Category: | J |
Sources
M ame | Type | Id | Format Lozation
4 New Source 1 Picture Dizplaykd ate. brap 10133248
4 New Source 2 Picture Fire Line Maireb... 10133248
e New Source 3 Picture Quanturn.brap 10133248
4 New Source 4 Picture RGE Alignment.b... 10133248
4 New Source 5 Picture HEA 0% White... 10133248
4 New Source B Picture HEd 30% White... 10133248
4 New Source 7 Picture HEd 507 White.... 10133248
4 New Source 8 Picture HEd TR White. . 10133248
4 New Source 9 Ficture HEn 907 White.... 10133248
4 New Source 10 Picture HEd Moire. brmp 10133248
4 New Source 11 Picture XEn Reverse Gr... 10133248
4 New Source 12 Picture HEd \White Bord... 10133248
4 New Source 13 Picture HED White Diag... 10133248
4 New Source 14 Picture test patter.bmp 10133248
A& New Source 15 RGB 81 1024s7E2@E0_.. 1013348
A& New Source 16 RGE 52 Mo Formnat Set 1013.3.48
| Cancel |

Figure 30. Quantum Sources Dialog Box

3. Inthe Sources panel of the dialog box, select the desired source. You can filter the
listed sources by selecting an option from the View By or Category
drop-down lists. You can also search for sources using the Search field.

NOTE: The Search field is case-sensitive.

4. Click OK.
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Deleting a Window
To remove a window from the scene or the window palette:

1. In the window palette or in the virtual display area, select the window to be removed
from the currently selected scene.

2. Do one of the following:
e Press the <Delete> key on your keyboard.
e Right-click on the window and select Delete Window from the drop-down menu.

e Click the L‘ button on the Window Properties toolbar.

Moving and Resizing a Window

The simplest way to resize and reposition a window is to use the dragging procedure
described below. To perform finer adjustments to the size and placement of the window, see
Using the Window Properties toolbar or Using the Window Size & Position dialog
box on the next page.

To move or resize a window in the virtual display area:

1. Select a window in the virtual display area or select an undocked window in the
window palette of the currently selected scene. In the virtual display area, the window is
highlighted as shown below:

Resizing Handles

Figure 31. Selecting a Window
2. Perform the following as needed:

e To resize the window, drag one of the resizing handles on the window border
until the window is the desired size. The mouse pointer changes to a double arrow
symbol, showing which direction the border can be moved.

To size the window to fit the entire display array, right-click the window and select
Full Screen from the drop-down menu.

e To move the window, click the window and drag it to a new location. The mouse
pointer changes to two crossed arrows while hovering over the selected window.

With the layout grid turned on, window borders automatically align or snap to the grid lines.
You can temporarily disable this feature by holding down the <Shift> key on your keyboard
while moving or resizing the window.

If necessary, you can hide the layout grid or change its spacing (see Changing the Virtual
Display Properties on page 59).
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Using the Window Properties toolbar

If you need to position or resize a window with pixel accuracy, you can use the Window
Properties toolbar (see figure 24, @), on page 41), as follows:

1.

If the Window Properties toolbar is not currently displayed, select Window Properties
Toolbar from the View menu. A check mark appears in front of the menu option and
the following toolbar is displayed:

H Position Y Position Width Height

| 1493 | sa0=+ | 8s3 | 480

Figure 32. Window Properties Toolbar
In the virtual display area, click on the window to be adjusted.

On the Window Properties toolbar, click the H Position and V Position Arrows to
adjust the window position, or enter positive or negative pixel values in the H Position
and Y Position fields and press <Enter> on your keyboard.

Click the width and Height Arrows to adjust the window size, or enter pixel values in
the Width and Height fields and press <Enter> on your keyboard.

Using the Window Size & Position dialog box

If you need to position or resize a window with pixel accuracy, you can use the Window
Size & Position dialog box.

1.

Right-click a window in the virtual display area of the currently selected scene and
select Adjust Position and Size from the drop-down menu. The Window Size &
Position dialog box opens.

Window Size & Position

Window size & position Postion Widh/Height

%l 0 vl 0 v .
- | 3 el [
W 00 H: =) v
Source window size e
Size
‘fidth - |B00 -~ W Variable aspect ratio
-
Height: (600 v

[Tok ] canea | ey |

Figure 33. Window Size & Position Dialog Box
Set the Variable aspect ratio check box as needed.

e Cleared — The vertical and horizontal sizes are locked together. The viewport
maintains the aspect ratio of the original source.

e Selected — The vertical and horizontal size can be adjusted independently.

Click the Position Arrows to adjust the window position or enter pixel values in the
X (left edge) and Y (top edge) fields.

Click the width and Height Arrows to adjust the overall window size or enter pixel
values in the W (width) and H (height) fields.
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5. To set the actual source element to a specific size (rather than the overall window size),
click the size Arrows to make the necessary adjustments.
Width and height values in the Source Window Size panel show the size of the source,
allowing for the width of any border or title text (see figure 34).

| 800 pixels |
[ [«———— 780 pixels ————— l

600 Pixels

[+— 520 Pixels

CAMERA 1

Overall Window Size = 800 pixels x 600 pixels
(including border and title text)

Source Element = 780 pixels x 520 pixels

Figure 34. Example of Window Sizing

6. Click Apply to update the display with the new settings and leave the dialog box open.
Click 0K to save the new settings and close the dialog box or click Cancel to keep the
existing settings.

Selecting the Window Style (Quantum Elite Models Only)

NOTE: The Quantum Connect Control Software does not support the use of window
styles.

Using the Quantum Elite, you can give each window a text label to identify the source on the
target display and a colored border if desired. Two types of text labels can be applied to a
window:

e Overlay text — Text is placed over the source.
e Title text — Text is placed above or below the source on a colored background.

The appearance of window text and borders is defined by a style. A style specifies the font,
size, color, and position of label text, as well as border width and color. Figure 35 on the
next page shows examples of different window styles.

By default, if a style that adds a border or title text is applied to a window, the overall
window size does not increase. The window source is scaled down to allow the border or
title text to fit within the same overall window size.

If you want the source to remain a specific size, manually set it to the required size using the
Window Position dialog box (see Moving and Resizing a Window on page 50 for more
information).

NOTE: Window styles are defined in an XML file called ESQuantumConfig.xml. To
change or add to the default styles provided in this version of the Quantum Control
Software, you can edit the parameters of this file (see Modifying Window Styles on
page 84).
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4

Window with Overlay Text
You can change the Overlay Text font, size,
and color. Text can be aligned vertically (top,
middle, or bottom) and horizontally (left,
middle, or right).

" CAMERA 1

Window with Title Text
Window with Border You can change the Title Text font, size,
and color. Background color is defined by
the border color. Text can be aligned
vertically (top or bottom) and horizontally
(left, middle, or right).

CAMERA 1
Window with Border and Title Text

Figure 35. Examples of Different Window Styles
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Changing the window style
To change the window style:

1. In the window palette or in the virtual display area of the currently selected scene (see
figure 24, @ or @, on page 41), select a window.

2. Right-click the window and select Window Properties from the drop-down menu. The
Set Window Properties dialog box opens.

3. Select the Window Styles tab and choose a style from the Styles list:

Window Styles I Window Text |

— Styles r~ Preview

Name

None
Default Style
Verdana
Sans Serif
Avial

Title Text Preview

Overay Text Preview

Figure 36. Window Styles Dialog Box

The Title Text Preview and Overlay Text Preview sections of this tab show the appearance
of text for the selected style. Selecting None produces a plain source window with no
border or title text.

NOTE: Only the size, font, and position of the label text and the size of the window
border are reflected on the virtual display. The text and border colors can be
viewed only in the Preview panel of the Window Styles dialog box and on the
actual display.
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Changing the window text
To change the text content of the window label:

1. In the window palette or in the virtual display area of the currently selected scene, select
a window.

2. Right-click the window and select Window Properties from the drop-down menu.
The Set Window Properties dialog box opens (see figure 37).

i~ ™y

Set Window Properties

Window Styles  Window Text |

 Title Text

Enter test here to be displaved az the window title text,
I thiz field iz l=ft emphy, the source name will be uzed as
the: title text.

— Owerlay Text

Enter text here to be displayed as the window averlay
text. IF thiz field is left emphy the window will not dizplay
any overlay text.

Ok I Cancel |

Figure 37. Window Text Dialog Box

NOTE: The content of text labels and overlays can be viewed only on the display.

3. Select the Window Text tab and enter the desired text in the Title Text and Overlay
Text fields.

NOTE: Ifthe Title Text field is empty, the source name is displayed as the title
text. If the Overlay Text field is empty, no overlay text is displayed.

4. When finished entering properties on both tabs, click 0K to close the window and
implement your changes.

Changing the Zoom Properties

By default, a window that contains a source displays the entire source frame. The source
is automatically scaled to fit within the window. However, if needed, you can zoom into any
part of the source frame, such as to exclude unwanted or irrelevant material.

The portion of the image that you can zoom into is called a “viewport” (see the example in
figure 38 on the next page). A viewport can:

e Be as small as 6 percent of the active source frame.

e Have the same aspect ratio as the source or be stretched in either the horizontal or
vertical direction.

e Be positioned (or panned) to view any part of the source frame.
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Regardless of the size, shape, or position of the viewport, the portion of the source image
that it contains fills the entire window (see figure 38).

Original Source

sl AutoPlay Backup Access Control Help
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= HDMI22
= HDMI31
= HDMI32

Untitled.ctp - Quantum El
File View Grid Window Scene |

ne@

= HDMI41
=
= HDMI5.1
= HDMI5.2
= HDMI61
= HDMI6.2
ifil picture L
=) AltPixels-1600x1200. ~
= DisplayMate.BMP 7
= FinelineMoireBMI| || e
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[No Display Processors connected [Scene delay = 100.00% of scene setting Validation Status

/4‘
Figure 38. Example of a Standard Viewport that Preserves the Aspect Ratio of the
Original Source

If the window does not have the same aspect ratio as the original source, the viewported
image is compressed or stretched to fit the window (see figure 39). To retain the aspect ratio
of the viewport, the window needs to be the same shape as the viewport.
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Figure 39. Example a Stretched Viewport
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The number of viewported windows that can be present within one scene is dependent on
source types as well as the size and shape of the windows.

NOTE: Zooming in on part of a source only enlarges the image detail that is already
present in the source signal. If the image detail is not of good quality, zooming in does
not increase the level of detail.

To change the viewport:

1. Right-click the window in the virtual display area (see figure 24, @), on page 41) and
select Zoom Properties from the drop-down menu. The Source Properties dialog

box opens.
Source Properties
Sowce Viewport
Fan Zocm/Shetch
£y &
- - -

0,00%.0.00c% 100.00%,100.00%
" Fine & Coarse
™ Vaiiabls aspect ratio

Rezat
_Gwes | [ ]

Figure 40. Source Properties Dialog Box
2. Setthe Variable aspect ratio check box as needed.

e Cleared — The vertical and horizontal zoom percentages are locked together. The
viewport maintains the aspect ratio of the original source.

e Selected — The vertical and horizontal zoom percentages can be adjusted
independently.

3. Select fine or coarse adjustment by clicking the appropriate radio button (Fine or
Coarse).

4. Click the Zoom/Stretch Arrows to change the size of the viewport
- Or -
Click and drag the handles of the viewport area to adjust the size.

To quickly return the Zoom and Stretch settings back to 100 percent (no viewport), click
Reset.

5. Click the Pan Arrows to change the position of the viewport
- Or -
Click and drag the viewport area to the desired position.

The target display updates in real time as you make changes to the zoom and pan
settings.

6. Click OK to accept the new viewport settings or click Cancel to retain the previous
settings.
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Changing the Layer of a Window

The layer of a window determines whether it appears in front of or behind other windows.
Only one window can exist on a layer. A layer is also known as a Z order or priority.

Layers are identified by a number and the higher the number, the further forward the
window. For example, a window on layer 3 appears in front of a window on layer 2, but
behind a window on layer 4. The farthest back is layer O.

To see the current layer number of a window, hover over the window in the window palette.
A pop-up opens showing the window number, its current layer, and source type.

NOTE: The maximum number of windows allowed within a scene is dependant on the
Quantum processor hardware. The maximum is 128 windows per output card (see
the Quantum User Guide for more information).

To change the layer:

1. Select a window in the window palette or in the virtual display area of the currently
selected scene.

2. Using the Window Properties toolbar, click one of the following buttons to change the
layer of the window. You can also use the Window menu to change the layer.

Buttons and Menu Options Window Movement

Ii Send backward by one layer.
Click

_Or_

From the Window menu, select
Send Back.

l:i Bring forward by one layer.
Click

_Or_

From the Window menu, select
Bring Forward.

Send to the back of all layers
Click Ei (such as layer 1).

_Or-

From the Window menu, select
Send to Back.

n Bring to the front of all layers.
Click

_Or_

From the Window menu, select
Bring to Front.
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Changing the Virtual Display Properties

Various properties of the virtual display area can be altered based on personal preference or
to assist in creating scenes in the Scene Design workspace. Most of these properties can
be changed using the Virtual Display Properties toolbar (see figure 24, @), on page 41).

Layout grid

The layout grid in the Scene Design workspace assists you in accurately placing windows
on the target display. When the grid is visible, the borders of all windows snap to the grid.

NOTE: When the grid is hidden, the snap to grid feature is disabled.

You can change the following grid properties:
e To show the grid:

+
+3¥+
Click the E button

_Or_

From the Grid menu, select Snap Grid. A check mark appears on the menu in front of
the option. This option is listed when no grid is visible.

e To hide the grid:

7
+3¥4
Click the x button

-or-
On the Grid menu, deselect Snap Grid.
e To temporarily disable the snap to grid feature:
Hold down the <Shift> key while placing or resizing the window.
You can change the number of vertical and horizontal lines in the layout grid.
¢ To increase the number of grid lines:

+++
. TiE
Click the button
- Or -
Press the <Page Down> key.
e To decrease the number of grid lines:

+++
++4

Click the **=l button
- or -

Press the <Page Up> key.
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Virtual display zoom

You can zoom in on the virtual display area to assist with accurately placing windows or you
can zoom out to see more of the target display (see figure 24, @), on page 41).

e To zoom in on the display:

Click the QJ button

- or -
From the View menu, select Zoom In
- Or' -

Press the <+> key.

e To zoom out of the display:

Click the g button

- Or -
From the View menu, select Zoom Out
- Or -

Press the <-> key.

NOTE: Zooming in on or out of the virtual display does not affect the content of the
real display.

Background color

In the virtual display area, you can change the color of the background and the virtual
display itself (see figure 24, @).

NOTE: Changing the color of the virtual display has no effect on the content of the real
display.

To change the background or virtual display color:

1. Right-click anywhere in the layout area (but not on a window) of the Scene Design
workspace and select either Change Background Color or Change Virtual Display
Color from the drop-down menu. The Color dialog box opens.

2. Select a predefined or newly defined color.
3. Click oK.
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Viewing a Project

This section describes the Scene Control task and procedures for setting views of scenes in
a project. Topics that are covered include:

e Using the Scene Control
e Using Auto Play

Using the Scene Control

The Scene Control task lets you recall specific scenes in your project by clicking a scene
control button on the computer screen. The layout and design of the buttons can be
customized to suit the end user.

To access the Scene Control:

1. Click the Scene Control button on the main application window taskbar
(see figure 2, @), on page 8).

The Scene Control workspace and Views toolbar open.

2. If the Views toolbar does not open, select its name from the Views menu.

Run View and Design View
There are two modes for viewing the Scene Control workspace:
e Run view
e Design view

To change modes, click the Toggle Design/Run Modes button on the Views %\
toolbar.

Run view

In run view mode, the Scene Selection buttons are active. To recall a scene, click the
appropriate Scene Selection button.

Here is an example of the Scene Control workspace in run view:

Figure 41. Scene Control Workspace in Run View
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Design view

In design view mode, you can customize the layout and design of the Scene Selection
buttons. To assist with button sizing and positioning, a layout grid is displayed.

Here is an example of the Scene Control workspace in design view:

T T T T© T T T T T T
F + + + + + + o+ + o+
ey + + + +
F + + + + +

F + + + + +

[P e e
|-+-++++
[ + + + +

Figure 42. Scene Control Workspace in Design View

Full Screen Mode

The Scene Control task can also be operated in full screen mode, in which only the
workspace area, which contains the Scene Selection buttons, is visible.

When full screen mode is active, the Scene Control automatically switches to run view
and access to all setup tasks is disabled. This mode is useful when the Quantum Control
Software will be controlled via a touch screen.

e To activate full screen mode from the Scene Control task, click the button on the

Views toolbar.
e To return to normal screen mode, press the <Esc> key on your keyboard.

Starting up in full screen mode

The Quantum Control Software can also open directly to full screen mode at startup. To do
this, create a Windows shortcut and specify a “switch” on the command line.

To start the Quantum Control Software in full screen mode:

1. Minimize (or close) the Quantum Control Software and any other Windows applications
so that you can see the desktop.

2. Create a new shortcut by right-clicking the desktop and selecting New > Shortcut from
the drop-down menu. The Create Shortcut dialog box opens.

3. Enter the command line. You can enter the path to the program or locate it by clicking
the Browse button. In a typical installation, the command line is:

Windows NT, 2000, and XP:
C:\Program Files\Extron\Quantum Elite\Quantum Elite.exe or
C:\Program Files\Extron\Quantum Connect\Quantum Connect.exe.

Windows 7 and 8:

C:\Program Files (x86)\Extron\Quantum Elite\Quantum Elite.exe or
C:\Program Files (x86)\Extron\Quantum Connect\Quantum Connect.exe.
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4. Select the mode in which to open the application by adding one of the following to the
command that you entered in step 3:

¢ For user mode: Add a space followed by-u to the end of the command line.

¢ For administrator mode: Add a space followed by -f at the end of the
command line.

5. Click Next.
6. Enter the name for the shortcut or accept the default name and click Finish.

7. If you want the new shortcut to execute when the operating system starts, copy or
move the shortcut to the Windows Startup folder. See the Windows Help system for
more information on how to do this.

Creating a Default Layout

You can have the Quantum Control Software create a default layout, comprised of a button
for each scene in your project. Generally, this function is used to create a new layout and
customize the layout as needed. Any customized settings that you have already created are
lost by using this function. To create a default layout:

1. Ensure that the Scene Control workspace is in Design View (the layout grid is visible).

2. Click the button on the Views toolbar. A Warning dialog box opens with a
reminder that any existing layout settings will be lost if you proceed.

3. Inthe Warning dialog box, click Yes to create a default layout or No to retain the
existing one.

Customizing the Layout

Changing background properties

You can set the background of the Scene Control workspace to be a solid color or a bitmap
image. To change the background:

1. Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

2. Right-click anywhere on the workspace background (but not on a Scene Selection
button). The Background Properties dialog box opens.

P ™,

Background Properties

Previe

Caolaur | Bitrap Manager

()8 | Cancel |

Figure 43. Background Properties Dialog Box
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3. Apply a solid color or a bitmap image.

¢ To apply a solid color:

a.

b.

c.
d.

In the Background Properties dialog box, click Colour. The Color dialog
box opens.

Select a predefined color from the Basic Colors palette or define a custom
color.

Click OK. This returns you to the Background Properties dialog box.
Click 0K on the Background Properties dialog box to apply the chosen color.

¢ To apply a bitmap image:

a.

b.

In the Background Properties dialog box, click Bitmap Manager. The
Bitmap Manager dialog box opens.

In the Available Bitmaps list, select an image name. If there are no bitmaps
listed or to add a new bitmap, see Using the Bitmap Manager on page 66.

Click 0K to return to the Background Properties dialog box.

Click 0K on the Background Properties dialog box to apply the chosen
image.

Moving and resizing a button

1. Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

2. Click a scene Selection button. It is highlighted with a dotted outline and resizing

handles.

Figure 44. Selecting a Scene Selection Button

3. Move and resize the button as needed.

e To resize the button, position the mouse pointer over one of the resizing handles
and drag the button border to the desired position. The mouse pointer changes to
a double arrow symbol, showing which direction the border can be moved.

¢ To move the button, position the mouse pointer within the button, hold down
the left mouse button, and drag the button to a new location. The mouse pointer
changes to a crossed arrow symbol.

By default, the button borders snap to the layout grid. You can temporarily disable grid snap
by holding down the <Shift> key on your keyboard while moving or resizing the button.

Changing the properties of a button

You can set the button background to be a solid color or bitmap image. You can also
change the text displayed on the button, including the font style, size, and color.

To open the Change Button Properties dialog box:

1. Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

2. Right-click the Scene Selection button. The Change Button Properties dialog box
opens (see figure 45 on the next page).
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r ™

Change Button Properties

Scene titls: Scene 2

Button Text:  |Scens 2

Previe

Fort | ™ Hide?

Calor | ak | Cancel |

Figure 45. Change Button Properties Dialog Box

Bitmap Manager

To change the text and font displayed on the button:

1.

o kD

In the Button Text field of the Change Button Properties dialog box, enter the
desired text.

NOTE: When the button is first created, the button text is copied from the scene
title. Any subsequent change to the scene title does not update the text.

Click Font to change the size, style, or color of the font. The Font dialog box opens.

Change the font settings as desired.
Click 0K to return to the Change Button Properties dialog box.
Click 0K to apply the new text and font settings.

To apply a solid color to the button:

1.

2.
3.
4.

In the Change Button Properties dialog box, click Color. The Color dialog box
opens.

Select a predefined color from the Basic Colors palette or define a custom color.
Click OK to return to the Change Button Properties dialog box.
Click 0K to apply the selected color.

To apply a bitmap image to the button:

1. Inthe Change Button Properties dialog box, click Bitmap Manager. The Bitmap
Manager dialog box opens.
2. Inthe Available Bitmaps list, select an image name. If there are no bitmaps listed or to
add a new bitmap, see Using the Bitmap Manager on the next page.
3. Click OK to return to the Change Button Properties dialog box.
4. Click 0K to apply the selected image.
TIPS:

* The edge color of a button is determined by the color applied to the entire button
and remains visible when an image is used.

e To improve the appearance of the button, first apply a color to the button that
matches the color of the image, then apply the image.

If you want to hide the button during Run View, select the Hide? check box in the Change

Button Properties dialog box.
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Changing the properties of multiple buttons

You can change certain properties (such as color and font size) of more than one button
simultaneously; however, you cannot move or resize several buttons at the same time. To
simultaneously change the properties of multiple buttons:

1.
2.

Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

In the workspace, ensure that the mouse pointer is not over a Scene Selection
button, then click and drag to draw a rectangle around the buttons you want to change.
When you release the mouse button, all Scene Selection buttons within the rectangle
are selected (with resizing handles).

Right-click on a button, if you want to copy the properties from that button
- Or‘ -
Right-click anywhere else in the workspace, if you want to obtain the default properties.

The Change Button Properties dialog box opens and Multiple selection is shown
in the preview panel.

In the Change Button Properties dialog box, make the necessary modifications to the
font color, font typeface, button color and image.

NOTE: You cannot change the button text when selecting multiple buttons.

In the Change Button Properties dialog box, click OK to apply the new properties to
all buttons in the selection.

Using the Bitmap Manager

Clicking Bitmap Manager in either the Background Properties dialog box or the Change
Button Properties dialog box opens the Bitmap Manager dialog box.

-

Bitmap Manager

Available Bitmaps: Preview:

Absztract_metal brp
fire. brp
green_stone. bmp

Bitmap Folder:
IE:\Program Files\Extron'duan  Browse |
Add Bitmap | Femove Bitmap

] | Cancel |

Figure 46. Bitmap Manager Dialog Box

Bitmaps (BMP files) that are applied to the buttons or background of the Scene Control
workspace are not saved with the project file. Instead, these files are copied to a separate
folder on the hard drive from which the Quantum Control Software accesses them.

NOTE: If you copy a project from one computer to another, you must remember to copy

the bitmaps as well.
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Any missing bitmaps are indicated on the appropriate button or background with a red X on
a blue background as shown below.

Figure 47. Missing Bitmap
To change the bitmap folder:

1. Inthe Bitmap Folder field of the Bitmap Manager dialog box, click Browse. The
Browse for Folder dialog box opens.

2. Select the appropriate folder.
3. Click OK.
To select an existing bitmap:

1. In the Available Bitmaps list of the Bitmap Manager dialog box, select the appropriate
file.

2. Click oK.

Adding, removing, or restoring a bitmap

To add a new bitmap:

1. Inthe Bitmap Manager dialog box, click Add Bitmap. The Open dialog box appears.
2. Locate the desired bitmap (BMP) file.

3. Click oK. The bitmap file is copied to the directory specified in the Bitmap Folder field
and appears on the Available Bitmaps list.

You can also copy files directly to the Bitmap folder using Windows Explorer. However,
you need to close the Bitmap Manager dialog box and reopen it to update the Available
Bitmaps list.

When the Quantum Control Software is first installed, the default location for storing bitmaps
is:

C:\Program Files (Program Files (x86) for Windows 7 and 8)\Extron\Quantum
Elite\Bitmaps

_or-

C:\Program Files (Program Files (x86) for Windows 7 and 8)\Extron\Quantum
Connect\Bitmaps.

To remove a bitmap:

1. From the Available Bitmaps list of the Bitmap Manager dialog box, select the file to be
deleted.

2. Click Remove Bitmap.

If the file is currently in use, a Warning dialog box opens asking whether to delete the
file. Click Yes to proceed.

The file is deleted from the list and the bitmap folder. If the bitmap was in use by any
buttons, those buttons now display a red X on a blue background (see figure 47).
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To restore a deleted bitmap:

e Follow the instructions for adding a new bitmap (see To add a new bitmap
on the previous page). If the file name of the restored bitmap is the same as the missing
bitmap, the image is restored to the appropriate button or background.

_Or-

e Copy the missing file to the bitmap folder using Windows Explorer. You must restart the
Quantum Control Software to fully restore the bitmap image to the appropriate button or
background.

Using Auto Play

When using the Auto Play function, the Quantum Control Software displays each scene
for a specified period, then switches to the next scene. The period of time that a scene is
displayed can be different for each scene.

When the project starts, it plays continuously until it is stopped. When the last scene is
reached, Auto Play cycles back to the first scene.

To use Auto Play, click the Scene Design button on the taskbar (see figure 2, @, @
on page 8 and Taskbar on page 9) to open the Scene Design task. The Scene

Design workspace opens.

The main features and toolbars associated with the Scene Design workspace are shown in
figure 24 on page 41.

Changing the Order of Scenes

In an Auto Play project, scenes are recalled in the order that they appear in the scene list on
the Scene Design workspace.

To move a scene on the scene list, drag and drop the scene title to a new position in the list
(see Working with Scenes on page 41).

Changing the Display Time for a Scene

Using the Scene Properties dialog box, you can choose whether or not a scene is
included in an Auto Play project and the length of time that it is displayed. To change the
display time:

1. Click the Scene Design button on the taskbar. The Scene Design workspace

opens (see figure 24).

2. For the currently selected scene in the scene list, click the button on the Scene
toolbar

- Or -
For any other scene, right-click a scene title in the scene list.

The Scene Properties dialog box opens. Ensure that the Properties tab is selected
(see figure 25 on page 42).

3. Modify the Auto Play Delay (mSec) setting, the Include Scene in Autoplay
setting, and other settings as needed. The value in the Auto Play Delay (mSec) field
is the amount of time that the scene is displayed in a project. The Include Scene in
AutoPlay check box, if selected, includes the scene in an Auto Play project.

4. Click OK.
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Starting and Stopping the Project

To start (play) the project: :
1. Click the Scene Design button on the taskbar (see figure 2, @, on page 8 @

and Taskbar on page 9). The Scene Design workspace opens (see figure 24
on page 41).

2. Click the E button on the Scene Control toolbar. The Autoplay mode dialog box
opens while Auto Play is active:

Autoplay mode

Click "STOP" on Scene Control toal
bar in "Scene Dezign' to stop

autoplay.

Figure 48. Autoplay Mode Dialog Box

The project plays continuously until it is stopped. When the project reaches the last scene,
Auto Play returns to the first scene.

To stop the project:

Click the E button on the Scene Control toolbar.

Changing the Playback Speed

When using Auto Play, the duration of displaying each scene is controlled by the Auto Play

Delay setting in the Scene Properties dialog box (see Changing the Display Time for a
Scene on the previous page). However, it is possible to speed up or slow down the rate of
display across the entire project.

To change the playback speed:
Use the following buttons on the Scene Properties toolbar in the Scene Design task:

Button | Function

- Increases playback speed. Each click decreases the normal delay time* of
=W/ | each scene by 10 percent, thus increasing playback speed.

=l Decreases the playback speed. Each click increases the normal delay
N Y time* of each scene by 10 percent, thus decreasing the playback speed.

*The normal delay time is defined by the Auto Play delay value on the Scene Properties
screen.

The current Auto Play time adjustment is displayed on the status bar, with the normal speed
being 100 percent. For example:

||S|:ene delay = 90,00%: of scene setking

Figure 49. Scene Delay Information on the Status Bar

Quantum Control Software ¢ Viewing a Project 69



Serial Commands

This section describes the format of the serial data strings that can be transmitted or
received by the Quantum Control Software. Topics include:

e Control of External Devices
e Remote Control of a Project
e Command Table

e ASCII Character Chart

Control of External Devices

To enable the control of external devices, those devices need to be connected to the Data
Tx output of the computer serial (RS-232) port.

The serial ports are usually identified as COMn, where n is a number from 1 through 4 (for
example, COM2). You must ensure that the appropriate serial port is configured correctly by
following the instructions in Communications Setup on page 19.

Serial data strings can be included within scenes (see Scene Commands on page 44). In a
scene, three strings can be transmitted:

e Pre Scene Commands — Commands that are performed as soon as the scene is
selected but not yet fully displayed.

e Post Scene Commands — Commands that are performed when the scene display is
fully complete.

e Exit Scene Commands — Commands that are performed when another scene is
selected but before the pre-scene commands of the new scene.

These commands can be used to control external source switchers or other RS-232
controllable devices.
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Format of External Control Strings

The exact content of the serial data string depends on the device you are controlling. See
the device user guide for information on supported commands.

A serial data string can comprise of ASCII text, hexadecimal data, and control characters.
Pauses can also be inserted as necessary to adjust the timing of the messages (see the

chart below).
Transmitted
Data String Information
Text characters using the computer keyboard Text Character
A caret (") followed by the control character Control Character

Example: ~M effectively sends a “carriage return.” For letters,
use only uppercase characters.

The hex pair preceded by a caret (%) and an “at” sign (@) Hex Data

Example: ~@4B~@24 transmits hex 4B and hex 24 (ASCI
characters K and $)

A caret (") followed by a comma. This delays transmission A Pause
of subsequent characters in the string by 100 milliseconds.
Pauses can be stacked to create longer delays.

Example: ~,",~,~,", gives a delay of 500 milliseconds
(0.5 seconds).

Examples of external control strings
Example 1: AUXB12"M

Transmits AUXB12 out of the serial port and terminates with a “M (carriage return).
Example 2: "@CO" @00~ @@2"@@P @15~ ,~,~,21C

Transmits the hex characters CO 00 02 00 15, pauses for 300 milliseconds, and then
sends the ASCII character 2! followed by a ~C (break).

NOTES:

e Most devices expect some kind of termination character at the end of a control
string. ~C (break) or M (carriage return) are used most frequently. However, this is
dependant on the hardware you are controlling. There is no standard for termination
characters.

e Any spaces entered within the data string are transmitted just like any other
character. Therefore, avoid entering or leaving spaces in a data string unless they
are specifically required by the receiving device.
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Remote Control of a Project

Remote control of a project is achieved by sending R-type messages to the Data Rx input
on one of the serial (RS-232) ports of the computer.

Alternatively, R-type messages can be created as simple ASCII text strings and transmitted
using suitable software, such as a terminal emulation program or a control system.

You can use the external control capability of a project. See Control of External Devices
on page 70 for information about remotely controlling another project running on a different
computer.

R-type Message Format

The standard R-type message structure is shown below with examples in ASCII format,
hexadecimal format, and mixed hex and ASCII format (see the ASCIlI Character Chart on
page 80 for reference).

A command string is constructed in the following format:
SOH R Data STX Command ETB ETX
Portions of the command string are defined as follows:

SOH (Start of Header) In hex, this is @1. In ASCII, this is ~A.

R This portion of the command string signifies that the message is an R-Type
command. In hex, this is @2.

Data This portion consists of the information to be executed. This information

is optional and is only required if the specific remote control command
requires additional information, such as a project name, to properly
execute the command.

STX (Start of Transmission) In hex, this is @2. In ASCII, this is B.
Command  This portion contains the remote command type.

ETB (End of Block) In hex, this is 17. In ASCII, this is “W.

ETX (End of Transmission) In hex, this is @3. In ASCI, this is ~C.

The contents of the portions denoted by Data and Command vary according to the required
function and can be determined from the command table. Hex portions in a command
string are denoted in brackets.

NOTE: The spaces between characters are included for clarity only and must not
appear in the transmitted message. The only permitted spaces within a string are in
scene names.

The following example is a remote control string in ASCII format. This example runs a scene
with the name “ATTRACT”:
“ARATTRACT "B@7 "W "C

e The hex version of the above command string is:
[B1]1[52][41][54]1[54][52][41][43]1[541[@2]1[30][37]1[17]1[93]

e A more common approach (compared to creating a string entirely in hex pairs or in
ASCII), is to mix hex and ASCII data. This makes the string more readable.

The mixed version of the above command string is:
[@1] RATTRACT [02] @7 [17] [93]
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Command Symbol Definitions

Bl & E

&l

& ]

&

H
X
[=)

EEEERE

Scene location in list (1 to 999)
Scene name (ASCII, case-sensitive)

Window number (@@30@ to @998, zero-based, leading zeros required)
Example: Window 25 = @@24

Zoom percentage (0@ to 999, leading zeros required)
@83 = No zoom
50@ = Zoom into 50 percent of image

Pan horizontal location (8@@ to 999, leading zeros required)
200 = Left-most edge of input video
500 = Middle of image horizontally

Pan vertical location (d@@ to 999, leading zeros required)
@0@ = Top-most edge of input video
500 = Middle of image vertically

Window horizontal position (- 9999 to 99999, leading zeros required)
- @500 = 500 pixels off screen to the left
21920 = 1920 pixels to the right of the left-most border

Window vertical position (-9999 to 99999, leading zeros required)
-050@ = 500 pixels above the top edge of the screen
01380 = 1080 pixels below the top border

Window horizontal size (@003 to 99999, leading zeros required)
00400 = 400 pixels wide

Window vertical size (@003 to 99999, leading zeros required)
2@303 = 300 pixels tall

Input source name (ASCII, case-sensitive)

Window style name (ASCII, case-sensitive)

Border or overlay onscreen text (ASCII, case-sensitive)
Merge scene name (ASCII, case-sensitive)

Window layer number (@ to 999)

File location including the full directory path.
Example: C:\Files\TestProject
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Command Table

Command

ASCII-Hexadecimal

Description

Recall Scene

Recall by list position

Example:

Recall by scene name
Example:

Recall next scene

Recall previous scene

[01]1RK[02]05[17] [93]
[@1]RO4[02]@5[17] [93]

[01]1RX2[02] 97 [17] [93]
[@1]RPRESET 2[@2]@7[17] [@3]
[11R[©2]@n[17][923]
[G1]R[02]0p[17][03]

Recall scene number [Xi] according to
the scene list.

Recall the fourth scene in the list in
the Scene Design task.

Recall scene [x2].

Recall scene named “PRESET 2.”
Recall next scene in the list.
Recall previous scene in the list.

Window Source

Select input

Example:

Select input in named scene

[01] RKax1][@2] 36 [17] [@3]

[01]ROOG4 Laptop Input[02]36[17][@3]

[01]Ri2, k3], x11][@2] 52 [17] [@3]

Select input x11] to be shown in
window [x3].

Set window 5 to display source
named “Laptop Input.”

Route input [x11] to window [X3] in
scene [x2].

NOTE: If you are using merge scenes, [X2l must be remerged for the change to occur. I

Autorun Controls

Begin from 1st scene
Begin from current scene
Increase autorun speed
Decrease autorun speed

Stop autorun sequence

[B11R[02]0@=[17][93]

[01]R[02]10>[17][03]

[B1]R[02]@+[17] [23]

[@1]R[02]1@-[17][03]

[B1]R[02]0<[17][@3]

Begin the autorun sequence with first
scene in the list.

Begin the autorun sequence from
currently displayed scene.

Increase the duration by 10 percent
for each scene to be displayed.

Decrease the duration by 10 percent
for each scene to be displayed.

Halt the autorun sequence.

Window Visibility

Hide Window
Example:

Hide Multiple Windows

[01]1RX3|@ [02]33[17] [@3]
[01] ROQGO50 [@2]33[17] [@3]

[01]1RK2,[x3,k3],0 [02] 63 [17] [@3]

Set window [x3] to be hidden.
Set window 6 to be hidden

Set window [x3] through [X3] in scene
[x2] to be hidden.

NOTE: If you are using merge scenes, X2 must be remerged for the change to occur. I
Show Window [91]1RX3[1[@2]33[17] [93] Sets window [x3] to be shown.
Example: [01]1ROOG51 [02]33[17] [@3] Sets window 6 to be shown.
Show Multiple Windows [@1]R[x2],x3],[x3],1[@2]163[17] [@3] Sets window [x3] through [X3] in scene
x2] to be shown.
NOTE: If you are using merge scenes, X2l must be remerged for the change to occur. I

NOTE: [xi] = Scene number
X2 = Scene name
X3 = Window number
11l = Input source name

Scene location in list (1 to 999)
ASCII, case-sensitive

9003 to @998, zero-based, leading zeros required
ASCII, case-sensitive
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Command ASCII-Hexadecimal Description

Window Size and Position

Set size and position [21] Rx3Ix7]Xelxelx10] [@2] 35 [17] [@3] Set window [x3] to position (X7, x8])
and size [x9] by [x10].
Example: [@1] ROVD4 0G300 00400 0P80 PB60T (2] 35[17] [93]
Set window 5 to position (300, 400)
and size 800x600.

Set parameters in named scene  [@1] Rx2, X3|x7Ixe|xglx10] [@2] 57 [17] [@3]  Set window [x3] in scene X2 to position
(7], [x8]) and size [x9] by [x10].

NOTE: If you are using merge scenes, [x2] must be remerged for the change to occur. I

Window Priority

Bring window to front [01]1R[X2,[x3],1[@2]78[17] [23] Bring window [x3] to be in front of all
windows.
Send window to back [01]RK2,Kx3],0[02]78[17] [@3] Send window [x3] behind all windows.
Example: [@1]RPRESET 2,0004,1[02]78[17][03]
Set window 5 in scene “PRESET 2” to
be in front.
Bring window forward [91]R[X2,[x3],x15, 1 [@2]79[17] [@3] Bring window [x3] forward layers.
Send window backward [@1]RkX2,[x3],x15, @ [02]179[17] [@3] Send window [x3] backward [X15]
layers.
Example: [@1]RPRESET 2,0004,3,0[02]179[17] [93]

Send window 5 in scene “PRESET 2”
backward 3 layers.

Zoom and Pan

Set zoom and pan [91] Rixa|xa][x5]xe] [@2] 34 [17] [93] Set window [x3] to have a zoom of
and pan of x5 and [xe].
Example 1: [01] ROVG4A 500000000 [@2]34[17] [93] Set window 5 to zoom in to

50 percent of the image and to
display the top left panel.

Example 2: [01] ROOGA 750750750 [@2]34[17] [D3] Set window 5 to zoom in to 25% of
the image and to display the bottom
right panel.

NOTE: [x2 = Scene name ASCII, case-sensitive
X3 = Window number 0020 to @998, zero-based, leading zeros required
= Zoom percentage 903 to 999, leading zeros required
[xs] = Pan horizontal location 203 to 999, leading zeros required
= Pan vertical location 903 to 999, leading zeros required
= Window horizontal position -9999 to 99999, leading zeros required
= Window vertical position -9999 to 99999, leading zeros required
= Window horizontal size 00903 to 99999, leading zeros required
= Window vertical size 00033 to 99999, leading zeros required
[x15] = Window layer number @ to 999
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Command ASCII-Hexadecimal Description

Zoom and Pan (continued)

Set horizontal and vertical zoom  [@1] R x3x7[xexs[xe] [@2] 4@ [17] [@3] Set window [x3] to have a zoom of
and horizontal and vertical pan horizontally and [x8] vertically, and a
pan of x5 and [xe].
Example: [@1] ROGG4 500 750000 000 [@2]134[17] [93]

Set window 5 to zoom in to

50% of the image horizontally and
25% vertically, and to display the top
left panel.

Set parameters in named scene  [@1] R X2, x3[xalxslxe] [@2] 58 [17] [23] Set window [x3] in scene [X2] to have a
zoom of x4 and a pan of x5 and [x8].

NOTE: If you are using merge scenes, X2] must be remerged for the change to occur. I

Coordinate system: 000, 000 999, 000
The horizontal and vertical pan settings allow you to position the [
upper left corner of the zoomed region on a 1000 x 1000 grid
that represents the original image.

500H, 500V
000, 999 990, 000
Set zoom and pan in named [21] R X2, kax7Ixelx5lxe] [@2] 59 [17] [@3]  Set window 3] in scene X2 to have a
scene zoom of [x7] and [x8] and a pan of [x5]
and [xe.
Window Style
Select style [01]RK3x12 [02] 37 [17] [@3] Set window [x3] to use predefined style
12|
Example: [@1]1R@BGAArial 2[02]37[17] [@3] Set window 5 to use window style
named “Arial 2.”
Select style in named scene [01]RkX2,[x3],x12[[02]53[17] [@3] Set window [x3] in scene [x2] to use
style x12].
NOTE: If you are using merge scenes, X2 must be remerged for the change to occur.
Define border text [01] Rx3x13][@2]38[17] [23] Set window [x3] to have border text
which states [x13].
Example: [01] ROGG4AAuxiliary Input[@2]38[17] [@3]

Set window 5 to have border text
stating “Auxiliary Input.”

NOTE: [x2] = Scene name ASCII, case-sensitive
X3 = Window number 0003 to @998, zero-based, leading zeros required
= Zoom percentage @03 to 999, leading zeros required
[xs] = Pan horizontal location @03 to 999, leading zeros required
= Pan vertical location @03 to 999, leading zeros required
= Window horizontal position -9999 to 99999, leading zeros required
= Window vertical position -9999 to 99999, leading zeros required
x12 = Window style name ASCII, case-sensitive
[x13] = Border or overlay onscreen text  ASCII, case-sensitive
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Command ASCII-Hexadecimal Description

Window Style (continued)

Set border text in named scene [01]RKx2,X3],x13][@2] 54 [17] [@3] Set window [x3] in scene 2| to have
border text [x13].
NOTE: If you are using merge scenes, X2l must be remerged for the change to occur. I
Define overlay text [01]RX3x13[@2]39[17] [@3] Set window [x3] to have overlay text
stating [x13].
Example: [01]1ROOP4 CONFIDENTIAL [@2]139[17] [93]

Set window 5 to have overlay text
stating “CONFIDENTIAL.”

Set overlay text in named scene  [@1] R[x2,[x3],X13][@2] 55 [17] [@3] Set window [x3] in scene 2| to have
overlay text x13].
NOTE: If you are using merge scenes, [x2l must be remerged for the change to occur. I

Batch Execute Commands

Begin command collection [61]R[02]41[17] [23] All commands after this string are
collected but not executed.
Execute collected commands [B1]R[02]42[17] [03] Execute all commands issued
between the Begin and Execute
strings.
Example: [01]R[©2]41[17] [03]

[91]RPRESET 2[©02]07[17] [93]

[@1] ROOG4 Laptop Input[02]36[17][03]

[91] ROPG4 CONFIDENTIAL [@2]38[17] [93]

[B11R[02]142[17] [23]
Begin collecting commands. The
following three commands are

executed simultaneously after the last
line is sent:
® Recall the scene named
“PRESET 2.”

® Set window 5 to display the
source named “Laptop Input.”

® Set window 5 to have overlay
text stating CONFIDENTIAL.

Merge Scene Controls

Create merge scene [01]1RKx4],,,1[02]51[17] [93] Create new merged scene [x14].
Add or remerge scene [@1]R[x14l, ,x2,1[02]151[17] [@3] Add or remerge existing scene [x2] to
merge scene [x14].
Delete scene [91]Rx1al,[x2], ,1[02]51[17] [@3] Remove scene [x2] from scene [x14].
Purge merge scene [B1]R[02]56([17] [@3] Remove all windows from the current
merge scene.
[@01]1Rx4,,,1[@2]51[17] [@3] Refresh merge scene [Xi4] to have all

windows removed.

NOTE: [x2 = Scene name ASCII, case-sensitive
X3 = Window number 2003 to @998, zero-based, leading zeros required
[x13] = Border or overlay onscreen text ASCII, case-sensitive
= Merge scene name ASCII, case-sensitive

Quantum Control Software ¢ Serial Commands

77




Command

ASCII-Hexadecimal Description

Save Current Project to File

Save current project

Example:

[Z1]1RKi6[02]11[17] [D3] Save current project to location

(includes the full directory path).

[@1]RC:\Files\ Save current projectto C: \Files
TestProject [02]11[17] [@3] with a filename of “TestProject.”

NOTE: The folder in which the file will be saved must already be created.

Examples of

R-type Messages

The following examples of R-type messages assume that there are five scenes in the
currently loaded project and that they appear in the scene list as:

Intro
Video

Demo
Conference

Finish

NOTE: The spaces between characters are included for clarity only and must not
appear in the transmitted message.

To select the Conference scene by its name:

“AR Conference "B@7 "W"C

To select the Demo scene by its position in the scene list:

“AR3 "B@5 "W"C

To select the next scene in the scene list:

~AR "B @n “W~C

To start AutoPlay from the first scene (in this case, the Intro scene):

~AR "B @="W"C

To stop AutoPlay:

~AR "B @< "W"C

To increase AutoPlay playback speed by 10 percent:

~“AR "B @+ "W"C

To hide or show window 7 in the current scene:

~AR 00@6 @ "B 33 "W~C (hides the window)
~AR @061 ~B 33 "W~C (shows the window)

To set window 4 to the “Warning” style:

~AR @@@3Warning "B37 "W"~C

To set the overlay text of window 4 to read “Incident Reported”:

~“AR@@3 Incident Reported "B39 "W~C

To set the viewport of window 5 to show a magnified area from the center of the

S

ource image:
~AR 0004 500 250 250 "B 34 "W~ C
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Merge Scene Commands

Merge scene commands (51-56) provide independent control of areas on a display wall that
are driven from a Quantum processor or array of processors. This is useful for installations
where more than one operator needs access to the display wall (see Working with Merge
Scenes on page 90 for more information about merge scene functions).

A merge scene allows sources on different areas of the display wall to be merged into the
overall scene.

To create a merge scene called “Merge Scene”:
“ARMerge Scene,,,1"B51"W"C

To add a scene called “Op 1 scene 1”7 in “Merge Scene”:
“ARMerge Scene,,Op1 scene 1,1"B51"W"C

NOTE: “Op1 scene 1” must already be created in the Quantum Control Software.

To remove the “Op1 scene 1”7 scene and add the “Op1 scene 2” scene to the merge
scene:
~ARMerge Scene,,0p1 scene 1,0p1 scene 2,1"B51"W"C

To change the source that is applied to a certain window in a scene, two commands
are sent:
~AROp1 scene 2,0,New Source 1"B52"W"C (applies “New Source 1”
source to window “0” in the “Op1 scene 2” scene)
~ARMerge Scene,,0p1 scene 2,1"B51"W~C (refreshes the merged
scene)

To change the window style, use command 53 and refresh the merge scene:
“AROp1 scene 2,0, Ariali1 "B53 "W"C
~“ARMerge Scene,,Op1 scene 2,1"B51"“W"C

To change the border text on a window, use command 54 and refresh the merge
scene:

~“AROp1 scene 2,0, Camerai5 "B54 “W"C

~“ARMerge Scene,,Op1 scene 2,1 "B51 " "W"C

To change the overlay text on a window, use command 55 and refresh the merge
scene:

~“AROp1 scene 2,0, Camerai15"B55 " "W"C

~“ARMerge Scene,,0p1 scene 2,1"B51"W"C

To remove all of the windows from the merge scene, use the Purge scene command
(56) and refresh the scene:

~AR *B56 "W~C

~ARMerge Scene,,,1"B51"W"C
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ASCII Character Chart

The ASCII character chart below is provided as a reference for creating your serial data

strings.
CTRL
Dec | Hex | ASCII Key Dec | Hex ASCII Dec | Hex ASCIl | Dec | Hex | ASCII

0 0 NULL @ 32 | Ox20 | <SPACE> | 64 0x40 @ 96 | Ox60 ’
1 1 SOH AA 33 | Ox21 ! 65 0x41 A 97 | Ox61 a
2 2 STX "B 34 | Ox22 : 66 0x42 B 98 | OxB62 b
3 3 ETX NC 35 | 0x23 # 67 0x43 C 99 | Ox63 c
4 4 EOT AD 36 | Ox24 $ 68 0x44 D 100 | Ox64 d
5 5 ENQ NE 37 | Ox25 % 69 0x45 E 101 | Ox65 e
6 6 ACK AF 38 | Ox26 & 70 0x46 F 102 | Ox66 f
7 7 BEL NG 39 | Ox27 ‘ 71 ox47 G 103 | Ox67 g
8 8 BS "H 40 | Ox28 ( 72 0x48 H 104 | Ox68 h
9 9 HT A 41 0x29 ) 73 0x49 I 105 | Ox69 i
10 A LF N 42 | Ox2A * 74 Ox4A J 106 | Ox6A j
11 B VT AK 43 | 0x2B + 75 0x4B K 107 | Ox6B Kk
12 C FF AL 44 | Ox2C , 76 0x4C L 108 | Ox6C I
13 D CR AM 45 | Ox2D - 77 0x4D M 109 | OxeD m
14 E SO AN 46 | Ox2E . 78 Ox4E N 110 | Ox6E n
15 F Sl NO 47 | Ox2F / 79 Ox4F O 111 | Ox6F o]
16 | 10 DLE AP 48 | 0x30 0 80 0x50 P 112 | Ox70 o)
17 | 11 DCH Q 49 | Ox31 1 81 0x51 Q 113 | Ox71 q
18 | 12 DC2 "R 50 | Ox32 2 82 0x52 R 114 | Ox72 r
19 | 13 DC3 NS 51 0x33 3 83 0x53 S 115 | Ox73 S
20 | 14 DC4 AT 52 | Ox34 4 84 0x54 T 116 | Ox74 t
21 15 NAK AU 53 | Ox35 5 85 0x55 U 117 | Ox75 u
22 | 16 SYN NV 54 | Ox36 6 86 0x56 V 118 | Ox76 %
23 | 17 ETB AW 55 | Ox37 7 87 0x57 wW 119 | Ox77 w
24 | 18 CAN AX 56 | Ox38 8 88 0x58 X 120 | Ox78 X
25 | 19 EM NY 57 | Ox39 9 89 0x59 Y 121 | Ox79 y
26 | 1A SUB N 58 | Ox3A : 90 Ox5A Z 122 | Ox7A z
27 | 1B ESC N 59 | Ox3B ; 91 0x5B [ 123 | Ox7B {
28 | 1C FS A\ 60 | Ox3C < 92 0x5C \ 124 | Ox7C |
29 | 1D GS A 61 0x3D = 93 0x5D ] 125 | Ox7D }
30 | 1E RS AN 62 | OxBE > 94 Ox5E A 126 | OX7E ~
31 1F us N 63 | Ox3F ? 95 Ox5F _ 127 | OX7F | <Del>
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Access Control

This section describes access control that is incorporated in the Quantum Control Software,
allowing different operators to gain access to different tasks. Topics that are covered
include:

e Login Procedure
e Enabling and Disabling Access Control
e Changing Level Passwords

Login Procedure

The Quantum Control Software incorporates an access control system that allows different
operators to have access to different tasks according to their needs and responsibilities.
This feature helps to prevent end users from being able to make unauthorized changes to
the setup of the Quantum Control system.

The following table lists the three available access levels and the tasks that are accessible to

each level.
Access Level
Task Administrator | Designer User
Choose Display X X
Processors
Choose Layout X
Communications Setup X
Set Up Sources X
Scene Design X X
Scene Control X X X
(See the note below.)
Remote Access Setup X X
EDID Minder X

NOTE: When you log in as a User, the Scene Control task opens in full screen mode
(run view only, not design view). To return to normal screen mode (such as to adjust
the brightness setting), press the <Esc> key on the keyboard. To return to full screen
mode, click the Scene Control button on the taskbar.

With the access control feature enabled, a Login dialog box opens each time you start the
Quantum Control Software (see figure 50 on the next page).
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Quantum Elite Login

£ Extron.
Quantum Elite

Th
rdi

User: o O
e

Figure 50. Login Dialog Box

To log in to the Quantum Control Software:

1. From the User drop-down list, select the desired role.

2. Inthe Password field, enter the required password for the chosen role.

3. Click 0K or press the <Enter> key on the keyboard to continue. The
Quantum Control Software splash screen appears for a few seconds, followed by the
main application window (see Main Application Window on page 8).

NOTES:

e By default, the password for each operator role is the same as the user name. For
example, for the User role, the password is User.

e Passwords are case-sensitive.

Enabling and Disabling Access Control

Following a new installation of the Quantum Control Software, the access control system is
disabled. Anyone using the application has access to all areas of functionality.

NOTE: Access control can be enabled by any user. However, after it has been enabled,
it can only be disabled by an Administrator.

To enable access control:

From the Access Control menu, select Enable Access Control. Access control is
enabled the next time you close and restart the Quantum Control Software.

To disable access control:

1. Start the Quantum Control Software application and log in as an Administrator
(see Login Procedure on page 81).

2. From the Access Control menu, select Disable Access Control. Access control is
disabled the next time that the Quantum Control Software is closed and restarted.
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Changing Level Passwords

By default, the password for each access level is the same as the level name. For example,
for the User level, the password is User.

NOTE: Passwords are case-sensitive. For example, if the password is User, entering
user or USER is not recognized.

It is recommended that the default passwords are changed as soon as possible after
installation. A password can contain any standard keyboard letters, numbers, or symbols
and can be any length.

Passwords can be changed only by an Administrator, following the login procedure.
To change a role password:
1. Start the Quantum Control Software and log in as an Administrator.

2. From the Access Control menu, select Change Access Passwords. The Change
Passwords dialog box opens.

. -

Change Passwords
Fole: I.ﬂ.dministratnr ;I
Password: I.-'-‘-.dministratu:ur

Cancel_|

Figure 51. Change Passwords Dialog Box
3. From the Role drop-down list, select the appropriate operator role.

4. The current password for that role appears in the Password field. Change the password
as needed.

5. Click 0K to save the new password or click Cancel to retain the existing password. The
new password takes effect the next time you close and restart the Quantum Control
Software.
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Reference
Information

This section discusses how to apply window styles to source windows on a Quantum
display by modifying the XML file installed with the Quantum Control Software. This section
also explains merge scene functionality and how to assign IP addresses for your devices.
Topics include:

e Modifying Window Styles
e Working with Merge Scenes
¢ |IP Addressing

Modifying Window Styles

Overview

The Quantum Control Software allows you to apply window styles to source windows on a
Quantum display. Styles specify the following features for source windows:

e  Border of a specified color and width
e Title bar of a specified font, size, and color
e Text overlay of a specified font, size, and color

Title text displays on a solid background that is the same color as the border. Overlay text is
placed on top of the source image and does not have a background.

NOTE: Although a window can have both overlay text and title text at the same time,
typically only one of these is used.

Styles are defined by an XML file that is installed on the PC hard disk when you install the
Quantum Control Software. You can add new styles or modify existing styles by editing the
XML file.

NOTES:

e The XML file is a separate file and is not part of the project (CTP) file. Always keep a
backup copy of the XML file. Any time you reinstall the Quantum Control Software,
the XML file is overwritten with the default version, and any changes that were
made to the file are lost. Copying projects from one computer to another requires
both the CTP and the XML files to be copied.

e After reinstalling the Quantum Control Software, always replace the default XML
file with your customized XML file before starting the Quantum Control Software.
Otherwise, if you start the application with a project file that references nonexistent
styles, the missing styles are removed from all affected windows. If the project file is
saved at this point, it is saved without the required styles. If you reinstall the correct
XML file at this point, you must manually reapply the missing styles to each affected
window in the project file.
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Locating and Opening the XML File

You can edit the XML file using Microsoft Notepad or a proprietary XML editor if available. To
edit the file using Notepad:

1. From the desktop, click Start > A11 Programs > Accessories > Notepad. This opens
the Notepad application.

2. From the File menu, select Open. The Open dialog box is displayed.
3. Fromthe Files of type drop-down list, select A11 Files.

4. Browse to and select the XML file. By default, the file is located in the following folder on
the computer hard disk:

C:\Program Files\Extron\Quantum Elite [or Connect]\XML\Quantum Source
Types

_or_

C:\Program Files (x86)\Extron\Quantum Elite [or Connect]\XML\Quantum
Source Types

The file is named ESQuantumConfig.xml.
5. Click open.
The XML file looks similar to the following:

' ESQuantumConfig. xm! - Notepad [|[=%]
File Edt Format View Help
<?xml wersion="1.0" encoding="UTF-8 ~
<l—— edited with ML Spy w4.2 U (http //www xmlspy. com) by Mmansal chamberlain (Royal Brompton Hospital) —-»
<ESquantum>
<OUtputModess>
<OUTRUTMO! Id="640x480 50HZ" mame="vaaA (630, 480) S0HZ" Pixels= 640 Lines= 480 refreshrate="50"/>
<OUTRUTMO; Id="640x480 G0OHz" “WGEA (680, 480) 60HZ" Pixels=" " "e0" e
<OUTRUTMO! Id="848x480 50Hz" (848, 480 SDHz“ i "
<outputMode Id="848x480 6OHz" (848, 480) &0Hz" =
<OUTRUTMO! Id="800x600 50Hz" (800, 600) S0H2"
<OUTRUTMO; I :“EOOXGQO 60HZ " 800, 600) 6OHZ" n E
<OUTRUTMO! I0="1024x768 50Hz" (1024 7687 50HZ" '1024" Lines="768" Refreshrate="50"/>
<Out putMo; Id="1024x768 60Hz" (1024, 768) 60Hz" Pixels="1024" Lin efreshrate="60" />
<outputMod Id—‘1280x768 50HZ" 2B0x768 (1280, 768) "oPi " N
<outputmode Id="1280x763 60Hz" 280)(768 (1280
<outputMode Id="1152x870 50Hz"
<outputMode Id="1152x870 60HzZ"

b R O O

<0utputMode Id="1280x1024 50Hz"

<outputMode Id="1280x1024 &0HZ"

<OUTpUTMO; Id="1400x1050 50Hz" SxGA+ (1400, 10500 50Hz"

<OUTPUTMO; Id="1400x1050 60HZ" SXGA+ (1400, 1050) 60Hz"

<OUTpUtMo; Td="1408x1050 50Hz" S¥GA+ (1408, 1050) 50Hz"

<outputMode Id="1408x1050 60Hz" SHGA+ (1408, 1050) 60H2”

<outputmode Id="1800x1200 50HzZ"

<outputmode Id="1600x1200 60Hz"

<outputMode Id="1280x720 S0Hz"

<QutputMode Id="1280x720 60Hz'

<outputMode Id="1380x765 50HZ"

<OUTpUTMO; Id="1360x768 6OHZ" = 60" /

<OUTPUTMO; I0="1520x1080 S50HZ" Nam "1080p (1920 10807 50HZ" Pixels="1920" Lines="1080" refreshrate="50"/>

<outputMode Id="1520x1080 60Hz" hame="1080p (1920, 10807 &0Hz" Pixels="1520" Lines="1080" refreshrate="60"/>
</0ut putMaodes>

<windowstyles>
<style Id="None" nName="Nong':>
<Title show="0" Font="verdana" size="12" Bold="0" HorizPosition="Centre" vertPosition="Top" Colour="255, 25[]

(<] I ] 2]

Figure 52. ESQuantumConfig.xml File

NOTE: Before you make any changes to this file, it is strongly recommended that
you create a backup copy. From the File menu, select Save As to open the Save
As dialog box and save a backup copy.

TIP: To make the text easier to read in Notepad, it is recommended that you turn
off the Wordwrap feature (via the Format menu).

6. In the file, scroll down to the <WindowStyles> (opening) tag. The lines of information
between this tag and the </WindowStyles> (closing) tag define all of the styles that
appear in the Quantum Control Software.
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Overview of the Style Tag

Each style is defined with a separate <Style> tag. For example, the tag for the default style
is defined by:

<Style Id="Default” Name="Default Style”>

<Title Show=”1” Font="Verdana” Size="14” Bold="1” HorizPosition="Centre”
VertPosition="Bottom” Colour="153,204,255” Flash="@”/>

<Overlay Show="1” Font="Verdana” Size="14” Bold="1” HorizPosition="Left”
VertPosition="Bottom” Colour="153,204,255” Flash="@”/>

<Border Show="@” Colour="51,51,51” Thickness="2” Flash="@"/>

</Style>

In the <Style Id="Default” Name ="Default Style”> line of the example:

Name is the name of the style as it will appear on the Window Styles tab of the Window
Properties dialog box in the Quantum Control Software.

Id is a short name or reference for the style and identifies the style in RS-232 control
messages.

The <Title> tag defines the attributes of the title bar, including font style, size, and
color:

<Title Show=”1” Font="Verdana” Size="14” Bold="1"
HorizPosition="Centre” VertPosition="Bottom” Colour="153,204,255”
Flash="@"/>

The <0Overlay> tag defines the attributes of the border:

<Overlay Show="1” Font="Verdana” Size="14” Bold="1"
HorizPosition="Left” VertPosition="Bottom” Colour="153,204,255”
Flash="¢g”/>

The <Border> tag defines the attributes of the border:
<Border Show="@” Colour="51,51,51” Thickness="2” Flash="@”/>
The </style> tag is the closing tag.

Many of the attributes are common to each tag and are listed in the Summary of Style
Attributes table on the next page.
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Summary of Style Attributes

Attribute Function Values
Show Sets the text or border as visible | e @ = hidden
or hidden. e 1 =visible
Font The font name chosen from the Default fonts are:
fonts that are installed on the e Arial
Quantum processor
P e \erdana
e Microsoft Sans Serif
e Tahoma
Size Sets the size of the font. The Depends on display resolution
larger the number, the bigger the | and size. Typically, a value from
text. 1@ through 4@ provides readable
results.
Bold Sets the font weight. * @ =normal
e 1=bold
HorizPosition Defines the horizontal alignment o Left
of the text. e Centre
e Right
VertPosition Defines the vertical alignment of e Top
the text. e Centre
e Bottom
NOTE: Center alignment is not
applicable to title text.
Thickness Defines the width of the border. Width in pixels. Typically 1 through
10 are acceptable values.
Colour Defines the color of the text or Values between @ and 255:
border using RGB colors. e 0,0,0 = black
e 255,255,255 = white
e 255,0,0 =red
e (,255,0 = green
° 0,0,255=Dblue
Flash Defines whether the text or border | ¢ @ = static
is static or flashing. e 1 =flashing
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Modifying an Existing Style

To modify an existing style:

1.

Edit the appropriate attributes as needed.

For example, to change the default style to use Arial font on the title bar with the text
aligned to the left, change the attribute values shown in italics:

<Style Id="Default” Name="Default Style”>

<Title Show="1” Font="Arial” Size="14” Bold="1” HorizPosition="Left”
VertPosition="Bottom” Colour="153,20@4,255” Flash="@"/>

<Overlay Show="1” Font="Verdana” Size="14” Bold="1"
HorizPosition="Left” VertPosition="Bottom” Colour="153,20@4,255”
Flash="@g”/>

<Border Show="@” Colour="51,51,51" Thickness="2" Flash="@"/>
</Style>

From the File menu in Notepad, select Save to save any changes that you made.
Restart the Quantum Control Software to load the new style.

Adding a New Style
The easiest way to add a new style is to copy and paste an existing style, then modify it.

For example, to create a new style called “My Style” with the following attributes:

Attribute Value
Font Tahoma
Size 12
Title Bar Text Bold No
Position Top Right
Colour 240,240, (Yellow)
Font Tahoma
Size 12
Overlay Text Bold No
Position Centre
Colour 240,0,0 (Red)
Border Width 8
Colour 128,128,128 (Gray)
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1.

Select an existing style in the XML file.

NOTE: You must include the opening and closing Style tag.

Fle Edit Format View Help

</outputModes >
<winauwstyms>
Style Id="None' Name="None's
<Title shows ont="verdana" Size="12" Bold="0" HorizPosition="Centre" VertPosition="Top" Colour="255,255,255" Flash="0"/>
Font="verdana” 5ize="10" Bold="0" HorizPosirion-"certre” vertPosition-"Middle” colour="0,0,255" Flash="0"/s
" colour="0,0,255" ThWCknESS “0" Flash="0"/>

</style>
<style Td="Default” name="befault style’s
<Title show="1" Fomt="verdana" size= 14 B0ld="1" Horizrosition="centre" vertposition="sortom’ Colour="153,204,255" lash="0"/
Font="verdana” Size="14" Bold="1" HorizPosition="Left" VertPosition="Bottom" Colour="153,204,255" Flash="0"/
" colour="51,51, 51" Tmcknes 2" ﬂashf 0"/

</stylex
«style Id Ama'\ ar
Tle show=
<Over'\ay Shon
<Eurder Shows
</5tyle:
<5tyle To-"artal 2*
<Title show=

‘arial no_gorgder's
ont="arfal" size="10" Bold="0" Horizposition="Left" vertposition="Tap" colour="235,255,255" Flash="0"/>
421" 5ize="10" Bold="0" Horizposition="Left" vertposition="Top" colour="233,235,255" Flash="0"/>
,0,255" Thickness="10" Flash="0"/>

2
nt rwa'\ Size="20" Bold='1" Horizrosition="Centre" vertPosition="Bottom" Colour="0,0,255" Flash="0!/>
Font="arial " size="10" Bold="0" HDMZPDSWUUH- ‘centre” vertposition="middle"” colour="23%,255,235" F'\ash—
colour="0,255,0" Thickness="5" Flash="0
</Style>
<style Td="verdana 1" Name="verdana 1 no Border’s
<Title show="1" Font="verdana" size="16" Bold="1" HorizPosition="Right" vertposition="Top" Colour="0,255,0" Flash="0
<overlay Shows"1" Font="verdana® size="24" Bold="0" HorizPosition-"Left” vertposition-"Top" Colour="255,0,0" Flash- o/>
Jeeyie <Eurder show="0" colour="255,0,0," Thickness="10" Flash="0"/>
</st
<5tyle m "verdana 2" Name='verdana 2>
tle Show="1" Font="verdana" 5ize="20" Bold="1" HorizPosition="Centre" VertPosition="Top" Colour="255,255,255" Flash="0
<over'\ay Shi="
<Border” show

>
Fnr’\t verdar\a size="10" BD]H s ) HDV"\ZPDS'HZ'\D?’\ “Centre" vertPosition="Bottom" Colour= 255 25542557 F'\E\Sh 0y
" colour="0,0,255" Thickness i ="0"/

</stylex
<style Td="verdana 37 wame="verdana 3"
<Title show= ont="verdana" Tstze 20" B0ld="1" Horizeosition="centre" vertPosition="Tap" Colour="255,255,255" Flash=
<overlay Sho Font="verdana" Size= 1 Bold="0" HorizPosition="Centre” vertPosition="Bottom" Colours"0,d,255" F'\ash o/>
<Border” Show="1" Colour="0,0,255" Thickness="5" Flash="0"/>
</stylexr
<Mwindowstyless
(s, ] @

4 ESQuantumCenfig.xml - Notepad g@

(]

[pe

Figure 53. Selecting an Existing Style in the XML File
Right-click the selected text and select Copy from the drop-down menu.

Paste the selected text between Style tags (after a </Style> tag and before the
<Style> tag that follows it). To do so:

a. Click behind a </Style> tag.

b. Press the <Enter> key. The cursor moves to a new line above the next <Style>

tag.

c. Pressthe <Tab> key on your keyboard to align the cursor with the previous
</Style> tag.

d. Right-click in the blank line and select Paste from the drop-down menu.

Modify the copied style to reflect the necessary attributes (see the Adding a New Style

table on the previous page). The text for the new style appears as follows:
<Style Id="MyStyle” Name="My Style”>

<Title Show=”1” Font="Tahoma” Size="12” Bold="@” HorizPosition="Right”

VertPosition="Top” Colour="240@,240,0” Flash="0"/>

<Overlay Show="1” Font="Tahoma” Size="12” Bold="@"
HorizPosition="Centre” VertPosition="Centre” Colour="240,0,0”
Flash="¢g”/>

<Border Show="@” Colour="128,128,128” Thickness="3” Flash="@"/>
</Style>

From the File menu in Notepad, select Save to save any changes that you made.
Restart the Quantum Control Software to load the new style.
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Working with Merge Scenes

Merge Scene Overview

A merge scene allows sources on different areas of a display wall to be merged into

the overall scene. The merge scene acts as a master scene while other scenes act as
subscenes. Each subscene is unique and is managed independently from one another. This
is useful when dividing the pixel map into logical groups or display areas for independent
control.

1. Define the independent displays or display groups and allocate one or more subscenes
for each.

2. Program and control the subscenes as needed.
3. Add or remove subscene data to or from the merge scene.

4. Refresh the merge scene. This is required in order for merge scene changes to take
effect.

Defining Displays or Display Groups

To create a merge scene, define which displays or display groups are to be independently
controlled.

In the following example, there are nine display groups:

e Display group 1 is a 2x4 videowall.

e Display group 2 through 9 are independent LCD panels.
In figure 54, the display group numbers are shown in white.

Subscenes
Videowallt Videowall5 Subscenes Subscenes Subscenes Subscenes
Videowall2 Videowall6 LCD1-1 LCD2-1 LCD3-1 LCD4-1
Videowall3 Videowall7 LCD1-2 LCD2-2 LCD3-2 LCD4-2

Videowalld Videowall8 LCD1-3 LCD2-3 LCD3-3 LCD4-3

(2 JCe JC JCe)

(e JCr ) e J( o)

Subscenes Subscenes Subscenes Subscenes

LCD5-1 LCD6-1 LCD7-1 LCD8-1
LCD5-2 LCD6-2 LCD7-2 LCD8-2
LCD5-3 LCD6-3 LCD7-3 LCD8-3

Figure 54. Display Groups
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Programming Subscenes

After you define the display groups, create the subscenes that belong to each group. In

the following examples, scene group 1 has eight subscenes titled “Videowall1” through
“Videowall8” (see figure 54 on the previous page). Each subscene has a unique layout.
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Workflow

The merge scene should be the only scene that is running (active) in the Quantum Control
Software. The merge scene is highlighted in the scene list to indicate that it is the currently
active scene.

NOTE: Direct all control commands to a specific subscene, not to the merge scene.

The following sample workflow uses the previous subscene examples.
1. Add a subscene to a merge scene. This essentially calls or runs the subscene.

For example, add Videowall1 to Merge Scene:
[@1] RMerge Scene,,Videowalll,1[@2]51[17] [@3]

2. Make the desired changes to a subscene.

For example, set Videowall1/Window1 to SourceRGB1:
[@1] Rvideowalll,@,RGB1 [@2]52[17] [@3]

3. Update the merge scene with the changed information from step 2, above.

NOTE: This step is required in order for changes to take effect.

For example, the following adds Videowall1 to the merge scene and applies updated
subscene information:

[@1] RMerge Scene,,Videowalll,1[@2]51[17] [@3]
4. Change one scene to the next scene.

For example, remove Videowall1 and add Videowall2:
[@1] RMerge Scene,Videowalldl,Videowall2,1 [@2] 51 [17] [@3]

The window index numbers in the merge scene increment dynamically. The window index
numbers in the subscene are left unchanged.

When making several changes to a subscene, it may be more efficient to wait until all of the
changes have been made before executing a final refresh of the merge scene.

For example:

Videowalll/Window1 set to SourceRGB1
Videowalll/Window2 set to SourceRGB2
Videowalll/Window3 set to SourceRGB3

[@1] Rvideowalll,@,RGB1[02]52[17] [93]

[@1] Rvideowalll,1,RGB3 [@2] 52 [17] [@3]

[@1] Rvideowalll1,3,RGB3 [@2] 52 [17] [@3]

[@1] RMerge Scene,,Videowalll,@[@2]51[17] [93]
[@1] RMerge Scene,,,1[02]151[17] [93]

It may be beneficial to write a subroutine that tracks which subscene is currently running
when you are changing scenes. The subroutine indicates the subscene that needs to be
removed from the merge scene before the next subscene can be added.
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IP Addressing

What is an IP Address?

A full explanation of IP addressing is beyond the scope of this user guide. However, the
following details provide enough information to get started.

An IP address is a 32-bit binary number that is used to identify each device on an Ethernet
network. This number is usually represented by four decimal numbers (each in the range
of 0 to 255) separated by dots, such as 198.123.34.240. This is called “dotted decimal
notation.”

An IP address is divided into two parts:
e Network identifier
e Host identifier

Each address on a given network must have the same network identifier value but have a
unique host identifier. As a result, there are different classes that define the range of valid
addresses and the parts of the address that are used for the network and host identifiers.

The most common IP address classes are:

Class Name Valid Address Range Identifier Arrangement
Class A 0.0.0.1 to 127.255.255.254 NNN . HHH . HHH . HHH
Class B 128.0.0.1 to 191.255.255.254 NNN . NNN . HHH . HHH
Class C 192.0.0.1 t0 223.255.255.254 NNN . NNN . NNN . HHH

NNN refers to the network identifier and HHH refers to the host identifier.

Choosing IP Addresses

If the Quantum Control Software computer and Quantum processors are directly connected
or connected via their own independent network, follow the guidelines below for choosing
the IP addresses.

However, if you intend to connect your computer and Quantum processors to an existing
network, you need to advise the network administrator and ask the administrator to allocate
suitable IP addresses.

On an independent network, it is generally recommended that you use the Class C format
(from 192.0.0.1 to 223.255.255.254).

There are two rules for choosing IP addresses:
e Network identifier must be the same for each IP address
e Host identifier must be unique for each address.

Applying these rules to Class C addresses, the first three decimal values of your IP address
must all be the same while the last value is used to uniquely identify each device.
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The following is an example of a valid Class C addressing scheme:

Device IP Address

Quantum Control Software Computer | 208.132.180.41
Quantum processor 1 208.132.180.42
Quantum processor 2 208.132.180.43

NOTE: The host identifiers (41, 42, and 43 in the above example) do not need to be
sequential or in any particular order. However, it is recommended that you group the
numbers for simplicity.

The following is an example of an invalid Class C addressing scheme:

Device IP Address

Quantum Control Software Computer | 208.132.180.41
Quantum processor 1 192.157.180.42
Quantum processor 2 209.100.123.43

NOTE: The above addresses are invalid because the network identifier for each address
is not the same even though each IP address is unique.

You can perform a test from your computer to check that a device at a particular address is
responding correctly (see Testing the Ethernet Link on page 6).

Subnet mask

The subnet mask is another 32-bit binary number that is used to “mask” certain bits of the
IP address. This provides a method of extending the number of network options for a given
IP address. It works by allowing part of the host identifier to be used as a subnet identifier.

It is important that you set the correct value for the subnet mask. The basic values depend
on the class of IP address being used.

Class Name Subnet Mask
Class A 255.0.0.0
Class B 255.255.0.0
Class C 255.255.255.0
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Extron Warranty

Extron Electronics warrants this product against defects in materials and workmanship for a period of three years
from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty
workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or components,
to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is
returned within the warranty period, with proof of purchase and description of malfunction to:

USA, Canada, South America,
and Central America:

Extron Electronics

1230 South Lewis Street
Anaheim, CA 92805

U.S.A.

Japan:

Extron Electronics, Japan
Kyodo Building, 16 Ichibancho
Chiyoda-ku, Tokyo 102-0082
Japan

China:

Extron China

686 Ronghua Road
Songjiang District
Shanghai 201611
China

Europe and Africa:
Extron Europe
Hanzeboulevard 10
3825 PH Amersfoort
The Netherlands

Middle East:

Extron Middle East

Dubai Airport Free Zone
F12, PO Box 293666
United Arab Emirates, Dubai

Asia:

Extron Asia Pte Ltd

135 Joo Seng Road, #04-01
PM Industrial Bldg.
Singapore 368363
Singapore

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not
authorized by Extron.

NOTE: If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return
Authorization) number. This will begin the repair process.

USA:
Asia:

714.491.1500 or 800.633.9876
©65.6383.4400

31.33.453.4040
81.3.3511.7655

Europe:
Japan:

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage
during shipment. Returned units must include the serial number and a description of the problem, as well as the
name of the person to contact in case there are any questions.

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality,
performance, merchantability, or fithess for any particular use. In no event will Extron Electronics be liable for direct,
indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been
advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may
not apply to you.

Extron Headquarters

+1.800.633.9876 (Inside USA/Canada Only)

Extron USA - West
+1.714.491.1500
+1.714.491.1517 FAX

Extron Europe
+800.3987.6673
(Inside Europe Only)
+31.33.453.4040
+31.33.453.4050 FAX

Extron USA - East
+1.919.850.1000
+1.919.850.1001 FAX

Extron Asia

+65.6383.4400
+65.6383.4664 FAX

Extron Japan
+81.3.3511.7655
+81.3.3511.7656 FAX

Extron China

+86.21.3760.1568
+86.21.3760.1566 FAX

Extron Middle East

+971.4.299.1800
+971.4.299.1880 FAX

Extron Korea

+82.2.3444.1571
+82.2.3444.1575 FAX

Extron India
1800.3070.3777
(Inside India Only)
+91.80.3055.3777
+91.80.3055.3737 FAX

© 2014 Extron Electronics All rights reserved. www.extron.com
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